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TÓM TẮT 

Tên đề tài: “Tính toán kiểm nghiệm khung xe ô tô Ford Ranger” 

Sinh viên thực hiện: Nguyễn Hoàng Ý 

MSSV: 103200038 

Lớp 20C4A 

Tính toán kiểm bền khung xe Ford Ranger là một quy trình quan trọng nhằm đảm 

bảo khung xe chịu được các tải trọng và điều kiện vận hành thực tế, đồng thời kéo dài tuổi 

thọ và tăng độ an toàn. Khung xe Ford Ranger, thuộc dòng xe bán tải, đóng vai trò là bộ 

phận chính chịu lực, hỗ trợ các cụm tổng thành như động cơ, hệ thống treo và thân xe. Quá 

trình kiểm bền bao gồm phân tích các dạng hư hỏng thường gặp như biến dạng, ăn mòn, 

hoặc nứt gãy do va chạm. Sử dụng phương pháp phần tử hữu hạn (FEM) với phần mềm 

như HyperWorks, các kỹ sư mô phỏng tải trọng (tĩnh, động, và va chạm), từ đó đánh giá 

ứng suất, biến dạng và độ bền khung. Kết quả giúp tối ưu hóa thiết kế, gia cố các điểm yếu 

và đảm bảo khung xe đáp ứng tiêu chuẩn an toàn cũng như hiệu suất vận hành. Trong 

khuôn khổ đồ án, những nội dung sau đã được thực hiện: 

− Thu thập dữ liệu lý thuyết và thực tế: 

− Tìm hiểu về kết cấu, vật liệu và nguyên lý làm việc của khung xe ô tô. 

− Thu thập thông số hình học và cơ lý tính của khung xe (từ tài liệu kỹ thuật, catalog). 

− Mô hình hóa 3D và chuẩn bị mô phỏng: 

− Xây dựng mô hình khung xe bằng phần mềm CAD  

− Chuyển đổi mô hình sang HyperMesh để chia lưới (mesh) và gán điều kiện biên, tải 

trọng. 

− Phân tích bằng phần mềm HyperWorks: 

− Sử dụng HyperView và OptiStruct để thực hiện phân tích tuyến tính tĩnh. 

− Quan sát kết quả: phân bố ứng suất, biến dạng, đánh giá độ cứng và độ bền. 

− Đánh giá và đề xuất. 
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KHOA CƠ KHÍ GIAO THÔNG 

 

ĐỀ CƯƠNG ĐỒ ÁN TỐT NGHIỆP 

TT Họ tên sinh viên Số thẻ SV Lớp Ngành 

1 Nguyễn Hoàng Ý 103200038 20C4A Kỹ thuật cơ khí 

1. Tên đề tài đồ án: 

Tính toán kiểm nghiệm khung ô tô Ford Ranger. 

2. Đề tài thuộc diện: ☐ Có ký kết thỏa thuận sở hữu trí tuệ đối với kết quả thực hiện 

3. Các số liệu và dữ liệu ban đầu: Ô tô Ford Ranger. 

4. Nội dung các phần thuyết minh và tính toán: 

TT Nội dung 

1 CHƯƠNG 1: MỞ ĐẦU 

1. Tổng quan về đề tài và lý do lựa chọn 

2. Mục tiêu nghiên cứu của đồ án 

3. Phạm vi và phương pháp nghiên cứu 

2 CHƯƠNG 2: GIỚI THIỆU CHUNG VỀ Ô TÔ FORD RANGER 

1. Tổng quan về dòng xe Ford Ranger 

2. Các dạng hư hỏng thường gặp của khung xe Ford Ranger 

3. Tổng hợp thông tin các dạng hư hỏng khung xe 

3 CHƯƠNG 3: KẾT CẤU KHUNG XE FORD RANGER 

1. Mô tả nhiệm vụ và kết cấu của khung xe Ford Ranger 

2. Số liệu của các cụm tổng thành lắp lên khung xe 

4 CHƯƠNG 4: CÁC CHẾ ĐỘ TÍNH TOÁN KHUNG XE 

1. Giới thiệu các chế độ tính toán khung xe 

2. Xây dựng mô hình tính toán cho từng chế độ làm việc 

5 CHƯƠNG 5: PHƯƠNG PHÁP TÍNH TOÁN PHẦN TỬ HỮU HẠN VÀ 

PHẦN MỀM MÔ PHỎNG 

1. Giới thiệu phương pháp phần tử hữu hạn trong phân tích kết cấu 

2. Tổng quan về phần mềm HyperWorks và ứng dụng trong mô phỏng kết 

cấu khung xe 

3. Quy trình mô phỏng trên HyperWorks 

6 CHƯƠNG 6: PHÂN TÍCH ĐỘ BỀN KHUNG XE FORD RANGER VÀ ĐỀ 

XUẤT CẢI TIẾN 

1. Xây dựng mô hình mô phỏng kiểm bền khung xe FORD RANGER trên 

phần mềm HyperWorks 

2. Đánh giá kết quả và đề xuất phương án cải tiến kết cấu khung xe 

7 CHƯƠNG 7: KẾT LUẬN VÀ ĐỊNH HƯỚNG PHÁT TRIỂN 

1. Kết luận về kết quả nghiên cứu 

2. Đề xuất hướng phát triển và ứng dụng thực tế 

5. Các bản vẽ, đồ thị (ghi rõ các loại và kích thước bản vẽ): 
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- Bản vẽ tổng thể ô tô Ford Ranger 

- Các bản vẽ kết cấu khung ô tô Ford Ranger 

- Các bản vẽ các chế độ tính toán khung; sơ đồ tính toán tương ứng với mỗi chế độ 

- Các bản vẽ kết quả tính toán 

- Các bản vẽ trình bày đề xuất phương án cải tiến kết cấu khung ô tô Ford Ranger và 

các bản vẽ kết quả tính toán với kết cấu khung mới. 

6. Tài liệu tham khảo 

[1]. Kết cấu và tính toán ô tô- TS Ngô Khắc Hùng (NXB Giao thông vận tải Hà Nội năm 
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[4]. Practical Aspects of Finite Element Simulation A Study Guide-3rd Edition Released 
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Simulation Tools in a Rollover Protection Development Process. Siemens Restraint 

Systems GmbH, Germany, Paper No. 05-0122 

[11]. Sidhu M.S., 2012. Rollover Bus. 2012 India HyperWorks Technology 
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[12]. Ying Yang, Guangyao Zhao, Dongbo Ma and Xiaobin Xu Mode calculation and 

testing of a car body in white. School of Mechanical Engineering and Automa- 

tion, Northeastern University, Shenyang, 110819, China Shenyang Aviation Vocational 

Technical College, Shenyang, 110043, China 201. 

[13].TS.Phan Minh Đức & Th.S. Lê Công Tín- Ứng dụng phần mềm Hyperworks tối ưu 

khung xe buýt Thaco City B60 (AN APPLICATION OF HYPERWORKS SOFTWARE 
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LỜI NÓI ĐẦU 

 

Cuộc cách mạng công nghiệp hiện nay đã mang đến những cơ hội lớn cho sự phát 

triển của khoa học kỹ thuật tại Việt Nam, đặc biệt trong lĩnh vực chế tạo và cải tiến các 

phương tiện giao thông. Trong bối cảnh đó, việc nghiên cứu và nâng cao chất lượng các 

loại xe tải, đặc biệt là xe Ford Ranger – một dòng xe bán tải phổ biến, đã trở thành nhu cầu 

cấp thiết. Đề tài "Tính toán kiểm nghiệm khung ô tô Ford RangerKiểm bền trên khung xe 

Ford Ranger" ra đời nhằm đáp ứng yêu cầu này, tập trung vào việc phân tích và cải tiến độ 

bền khung xe trong điều kiện vận hành thực tế tại Việt Nam. 

Với sự hỗ trợ của các phương pháp mô phỏng hiện đại, đặc biệt là phần mềm 

HyperWorks, nghiên cứu này không chỉ giúp đánh giá chính xác các yếu tố ảnh hưởng đến 

độ bền khung xe mà còn mở ra cơ hội áp dụng công nghệ tiên tiến vào thực tiễn sản xuất. 

Việc lựa chọn khung ô tô xe Ford Ranger làm đối tượng nghiên cứu xuất phát từ những 

phản hồi thực tế của người dùng, cho thấy các vấn đề như nứt gãy hoặc biến dạng khi vận 

hành trên địa hình gồ ghề hoặc chở tải nặng. 

Trong thời gian làm đồ án mặc dù nhóm đã cố gắng hết sức nhưng chắc chắn sẽ có 

những thiếu sót là điều không thể tránh khỏi. Với khối lượng thực hiện đồ án này là một 

công việc khá lớn nhưng với sự giúp đỡ của các Thầy Cô giáo trong bộ môn, đặc biệt là 

dưới sự hướng dẫn nhiệt tình của T.S Phan Minh Đức nên em cũng đã hoàn thiện một 

cách tốt nhất cho Đồ án tốt nghiệp này. 

Kính mong đề tài này sẽ nhận được sự quan tâm và góp ý từ các thầy cô. 

 

 

 

 

Đà nẵng, ngày  … tháng …năm 2025 
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LỜI CAM ĐOAN 

Em xin cam đoan đây là đề tài riêng của riêng em, đề tài không trùng lặp với bất kỳ đề tài 

đồ án tốt nghiệp nào trước đây. Các thông tin, số liệu được sử dụng và tính toán đều từ 

các tài liệu có nguồn gốc rõ ràng, theo quy định.   
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1. Các kí hiệu: 

 

Ký hiệu Thứ nguyên Diễn giải 

V [ / ],[ / ]km h m s  Vận tốc 

W [W]  Công suất 

D [mm]  Chiều dài cơ sở xe 

R [mm]  Chiều rộng cơ sở xe 

C [mm]  Chiều cao cơ sở xe 

d
V  3[ ]cm  Dung tích xilanh 

L [mm]  Chiều dài Chassis 

0
G  [kg]  Trọng lượng không tải của xe 

1
G  [kg]  Trọng lượng thùng hàng và hàng hoá 

X [mm]  Toạ độ trọng tâm khung xe 

d 3[g/m ]  Trọng lượng riêng 

T [ ]C  Điểm nóng chảy 

  2[mm /s] Độ thấm từ 

v   Hệ số Pison 
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Chữ cái viết tắt 

LS-DYNA Livermore Software 

CAD Computer-Aided Design 

RBE2 Rigid Body Element 2 

MMA Motor Mixing Algorithm 

CFD Computational Fluid Dynamics 

NX NX Unigraphics 

QI Quality Index 

STEP Standard for the Exchange of Product Model Data 

SPH Smoothed Particle Hydrodynamics 

CAE Computer-Aided Engineering 

CFD Computational Fluid Dynamics 

CAM Computer-Aided Manufacturing 
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CHƯƠNG 1: MỞ ĐẦU 

 

1. Tổng quan về đề tài và lý do chọn đề tài 

1.1. Tổng quan về đề tài. 

Việc kiểm tra độ bền khung xe Ford Ranger trở nên cấp thiết do những phàn nàn 

ngày càng tăng từ người dùng về các vấn đề hư hỏng. Những sự cố này không chỉ ảnh 

hưởng đến độ an toàn mà còn làm giảm uy tín của sản phẩm, đòi hỏi một nghiên cứu kỹ 

lưỡng để giải quyết các vấn đề thực tế mà người dùng đang gặp phải. 

Tại Việt Nam, nhiều khách hàng đã bày tỏ sự không hài lòng khi khung xe xuất hiện 

các vấn đề như nứt gãy hoặc biến dạng tại các điểm nối khi vận hành trên địa hình gồ ghề 

hoặc chở tải nặng. Tình trạng này không chỉ làm giảm độ an toàn mà còn gây ảnh hưởng 

tiêu cực đến uy tín của sản phẩm. Trên thị trường quốc tế, đặc biệt tại Úc và Thái Lan – 

nơi Ford Ranger là dòng xe bán tải phổ biến, khách hàng cũng liên tục phản ánh về độ bền 

khung xe không đáp ứng được kỳ vọng khi sử dụng trong điều kiện khắc nghiệt, dẫn đến 

áp lực lớn đối với hãng trong việc cải thiện thiết kế và chất lượng khung xe. 

Đề tài mang tính đổi mới thông qua việc áp dụng phần mềm HyperWorks kết hợp 

với các phương pháp phân tích cấu trúc tiên tiến và mô phỏng số hóa để kiểm tra độ bền 

khung xe Ford Ranger. HyperWorks cho phép mô phỏng chi tiết các điều kiện tải trọng và 

dự đoán các điểm yếu cấu trúc với độ chính xác cao. So với các phương pháp truyền thống, 

nghiên cứu này tích hợp công nghệ mô phỏng hiện đại, mang lại các giải pháp cải tiến phù 

hợp với điều kiện thực tế tại Việt Nam. 

Kết quả của đề tài có thể được ứng dụng trực tiếp trong việc cải tiến thiết kế khung 

xe Ford Ranger, giúp tăng độ bền và tuổi thọ của xe trong môi trường khai thác khắc nghiệt. 

Ngoài ra, phương pháp nghiên cứu sử dụng HyperWorks có thể được mở rộng để áp dụng 

cho các loại xe khác, đóng góp vào việc nâng cao chất lượng sản xuất và an toàn giao thông 

tại Việt Nam. 

 1.2. Lý do chọn đề tài 

− Nghiên cứu giúp đánh giá và đề xuất các giải pháp tăng độ bền khung xe, tối ưu kết 

cấu, giảm trọng lượng nhưng vẫn đảm bảo độ cứng vững. 

− Kết hợp lý thuyết và mô phỏng thực tế. 

− Giải quyết vấn đề thực tế và hư hỏng khung xe. 
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− Hỗ trợ phát triển ngành công nghiệp ô tô tại Việt Nam. 

2. Mục tiêu nghiên cứu  

− Làm chủ công nghệ tính toán, đánh giá độ bền phân tích kết cấu khung xe Ford 

Ranger: 

− Xây dựng được mô hình phần tử hữu hạn của khung xe 

− Đánh giá độ bền của khung xe trong các trường hợp. 

− Đề xuất giải pháp 

 Dựa trên kết quả phân tích, đưa ra các giải pháp cụ thể như cải thiện hiệu suất, khả 

năng vận hành và giải quyết được phàn nàn, phản hồi từ khách hàng của Ford Ranger. 

3.Đối tượng và phạm vi nghiên cứu. 

− Đối tượng nghiên cứu: 

Đối tượng nghiên cứu của đề tài là khung xe Ford Ranger – một dòng xe bán tải phổ 

biến, tập trung vào việc đánh giá độ bền và khả năng chịu tải của khung xe trong các điều 

kiện vận hành thực tế. Nghiên cứu sẽ phân tích các đặc tính cơ học, cấu trúc vật liệu và các 

điểm yếu tiềm ẩn của khung xe thông qua mô phỏng bằng phần mềm HyperWorks. 

− Phạm vi nghiên cứu: 

Phạm vi nghiên cứu bao gồm việc mô phỏng và phân tích độ bền khung xe Ford Ranger 

trong các điều kiện tải trọng điển hình tại Việt Nam, như địa hình gồ ghề và tải nặng. Phân 

tích độ bền, biến dạng, ứng suất tập trung dưới tác dụng của các loại tải trọng cơ bản (tải 

trọng đứng, tải trọng phanh, tải trọng vào cua). Nghiên cứu tập trung vào việc ứng dụng 

HyperWorks để mô phỏng, không bao gồm thử nghiệm thực tế trên xe. 

Đối tượng nghiên cứu: Kết cấu khung xe Ford Ranger 

− Phạm vi mô phỏng: 

Phân tích độ bền, biến dạng, ứng suất tập trung dưới tác dụng của các loại tải trọng cơ 

bản (tải trọng đứng, tải trọng phanh, tải trọng vào cua). 

− Phân tích độ cứng vững của khung xe trong bài toán uốn và xoắn. 

+Đánh giá tổng quan về khả năng làm việc của kết cấu qua các chỉ tiêu như phân bố 

ứng suất, hệ số an toàn, biến dạng cực đại. 

+Không đi sâu vào mô phỏng va chạm (crash simulation) hay dao động tự do phức tạp 

ngoài phạm vi cần thiết cho kiểm nghiệm cơ bản. 
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4. Phương pháp nghiên cứu 

Phương pháp nghiên cứu dựa trên việc kết hợp các kỹ thuật mô phỏng số hóa và phân 

tích cấu trúc bằng phần mềm HyperWorks. Cụ thể: 

− Thu thập dữ liệu lý thuyết và thực tế: 

− Tìm hiểu về kết cấu, vật liệu và nguyên lý làm việc của khung xe ô tô. 

− Thu thập thông số hình học và cơ lý tính của khung xe (từ tài liệu kỹ thuật, catalog, 

đo thực tế). 

− Mô hình hóa 3D và chuẩn bị mô phỏng: 

− Xây dựng mô hình khung xe bằng phần mềm CAD (như SolidWorks hoặc Catia). 

− Chuyển đổi mô hình sang HyperMesh để chia lưới (mesh) và gán điều kiện biên, tải 

trọng. 

− Phân tích bằng phần mềm HyperWorks: 

− Sử dụng HyperView và OptiStruct để thực hiện phân tích tuyến tính tĩnh. 

− Quan sát kết quả: phân bố ứng suất, biến dạng, đánh giá độ cứng và độ bền. 

− Đánh giá và đề xuất: 

+So sánh kết quả mô phỏng với tiêu chuẩn an toàn hoặc giá trị cho phép. 

+Đề xuất phương án cải tiến thiết kế nếu cần (tăng cường gân, thay đổi vật liệu) 
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CHƯƠNG 2: GIỚI THIỆU CHUNG VỀ Ô TÔ FORD RANGER 

 

1.Tổng quan về dòng xe Ford Ranger  

1.1.Lịch sử hình thành.  

Ford Ranger là một dòng xe bán tải nổi tiếng của hãng Ford, được thiết kế và phát triển 

bởi đội ngũ chuyên gia hàng đầu tại Trung tâm Nghiên cứu và Phát triển Sản phẩm toàn 

cầu của Ford ở Úc. Được ra mắt tại nhiều thị trường trên thế giới, Ford Ranger nổi bật với 

khả năng vận hành mạnh mẽ, vượt qua nhiều loại địa hình và chinh phục các điều kiện 

khắc nghiệt. Tại Việt Nam, Ford Ranger là một trong những dòng xe bán tải phổ biến nhất, 

được ưa chuộng trong các ngành công nghiệp, nông nghiệp và cả sử dụng cá nhân nhờ thiết 

kế cứng cáp, động cơ bền bỉ và khả năng chịu tải tốt. 

− 1982: Ford Ranger tại Hoa Kỳ: 

Vào ngày 13 tháng 1 năm 1982, chiếc Ford Ranger đầu tiên ra mắt công chúng tại Triển 

lãm ô tô Syracuse dưới dạng một sản phẩm mới sẽ được bán vào năm 1983. Mặc dù có 

kích thước nhỏ gọn nhưng chiếc xe tải vẫn có đủ chỗ cho ba người và có tải trọng 1.600 

pound (725 KG), đồng thời mang lại sự mạnh mẽ và tiết kiệm nhiên liệu huyền thoại của 

Ford. 

− 1998: Chiếc Ford Ranger toàn cầu: 

Cái tên Ranger lần đầu tiên xuất hiện trên các xe bán tải dành cho thị trường Châu Âu 

và Châu Á vào năm 1998. Ranger thay thế cho Courier, cái tên đã từng là gương mặt đại 

diện của Ford trong khu vực trong hơn 30 năm. Ranger được giới thiệu với ba kiểu cabin, 

hai tùy chọn chiều dài cơ sở và nhiều lựa chọn động cơ mạnh mẽ, hiệu quả. Đây là một 

trong những chiếc xe đầu tiên được chế tạo tại nhà máy AutoAlliance Thái Lan ở Rayong. 

− 2005: Ranger Wildtrak xuất hiện: 

Phiên bản cao nhất của Ranger vào thời điểm đó là Wildtrak. Phiên bản này đã giúp 

khách hàng thực hiện những công việc khó khăn và đồng thời đáp ứng các mục đích giải 

trí và thỏa mãn đam mê. Với bánh xe lớn hơn, thanh thể thao độc đáo, thanh ray ở thùng 

xe, thanh ray nóc và bậc lên xuống, Wildtrak được trang bị để thỏa mãn mọi nhu cầu. 

Những tính năng này vẫn là trọng tâm trong thiết kế của Wildtrak cho đến ngày nay. 

− 2006: Ford Ranger Thế hệ Thứ hai: 

Với các đặc điểm thiết kế của dòng xe bán tải toàn cầu và hai tùy chọn động cơ diesel, 

Ranger đã thiết lập các tiêu chuẩn mới về độ hiệu quả và tin cậy. Vào thời điểm này, sản 
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phẩm Courier đã không còn được duy trì ở Australia, đồng thời một bản nâng cấp vào năm 

2009 cho Ranger đã giới thiệu thiết kế lưới tản nhiệt ba thanh mới và phiên bản thể thao 

Wildtrak cao cấp nhất đã lan rộng ra nhiều thị trường hơn. 

− 2011: Ford Ranger Thế hệ Thứ ba: 

Ranger thế hệ thứ ba đã được ra mắt tại Triển lãm ô tô quốc tế Úc 2010 ở Sydney. Được 

thiết kế, chế tạo và phát triển tại Úc, chiếc Ranger này đã thay thế hai biến thể riêng của 

khu vực bằng một chiếc xe bán tải cỡ trung dành cho toàn cầu. Được quảng cáo là chiếc 

xe bán tải cỡ trung mạnh mẽ nhất mà Ford từng chế tạo, chiếc bán tải hoàn toàn mới này 

được sản xuất tại Rayong, Thái Lan và Silverton, Nam Phi, đồng thời được phân phối tới 

hơn 180 quốc gia. 

− 2015: Facelift cho Ranger Thế hệ Thứ ba 

Các nguyên tắc thiết kế động học mới của Ford với tên gọi Kinetic đã định hướng cho 

thiết kế của Ranger phiên bản nâng cấp. Nổi bật với lưới tản nhiệt một thanh hình bầu dục 

thay thế cho thiết kế ba thanh hình chữ nhật. Nội thất cũng được thiết kế lại với thiết kế 

bảng điều khiển trông cứng cáp hơn kết hợp với màn hình SYNC trung tâm. Ranger cũng 

giới thiệu những công nghệ lần đầu tiên xuất hiện trong phân khúc, bao gồm hỗ trợ giữ làn 

đường, kiểm soát hành trình thích ứng và hỗ trợ đỗ xe phía trước và sau. 

− 2016: Ford Thái Lan: 

Nhà máy Sản xuất Ford Thái Lan (FTM), khai trương vào năm 2012, đã bắt đầu sản 

xuất Ranger mới để đáp ứng nhu cầu toàn cầu. 

− 2018: Ranger Raptor xuất hiện 

Ra mắt tại Thái Lan vào tháng 2 năm 2018 và được phát triển bởi Ford Performance tại 

Úc, Ranger Raptor đã nâng hiệu suất địa hình lên một tầm cao mới cho những thị trường 

không có F-150 Raptor. Với động cơ diesel bi-turbo 2.0 lít mạnh mẽ, hộp số tự động 10 

cấp, hệ dẫn động bốn bánh, khung gầm được nâng cấp và hệ thống treo FOX được tinh 

chỉnh đặc biệt để phù hợp với việc đi địa hình, Ranger Raptor đã làm hài lòng các chủ sở 

hữu cũng như các phóng viên báo chí được trải nghiệm. 

− 2019: Ranger trở lại thị trường Hoa Kỳ 

Mang vẻ bề ngoài tương tự như Ranger toàn cầu, mẫu xe của thị trường Hoa Kỳ có một 

số thay đổi về thiết kế – bao gồm tấm cản bằng thép gắn trên khung – để tuân thủ các quy 

định của Hoa Kỳ và giúp tăng khả năng chịu tải. Quá trình sản xuất của mẫu xe này bắt 

đầu vào ngày 29 tháng 10 năm 2018 tại Nhà máy lắp ráp Michigan ở Wayne, Michigan. 
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− 2021: Ranger Thế hệ Thứ tư ra mắt 

Ranger toàn cầu thế hệ thứ tư được công bố vào tháng 11 năm 2021. Với diện mạo hoàn 

toàn mới và cách tiếp cận thiết kế và phát triển tập trung vào khách hàng, Ranger mới có 

nhiều tính năng công nghệ cao hơn, kết nối thông minh, khả năng vận hành vượt trội, khả 

năng chịu tải tốt hơn và linh hoạt hơn bao giờ hết. Dự án Ranger toàn cầu được dẫn dắt bởi 

nhóm thiết kế và kỹ thuật của Ford tại Úc, với sự hỗ trợ từ các nhóm phát triển sản phẩm 

và chuyên môn từ mạng lưới các kỹ sư và nhà thiết kế toàn cầu của Ford. 

− 2022: Ranger Raptor Mới xuất hiện 

Vào ngày 22 tháng 2, Ford đã tiết lộ biến thể hiệu suất cao nhất của Ranger – Ranger 

Raptor – được thiết kế với công nghệ thông minh hơn để kiểm soát các trang bị thế hệ mới 

cứng cáp hơn. 

− 2022: Ranger Raptor thống lĩnh giải Baja 1000 

Ranger Raptor là chiếc xe luôn sẵn sàng cho những cuộc đua, nhưng vẫn hoàn toàn hợp 

pháp để lưu thông trên đường, chiếc xe đã có màn trình diễn gần như hoàn hảo qua một 

trong những cuộc đua địa hình khắc nghiệt và nổi tiếng nhất thế giới SCORE-International 

Baja 1000 ở Mexico và sau đó quay trở lại Riverside, California. Chiếc xe bán tải hiệu 

năng cao đã được Kelly Racing chuẩn bị cho cuộc đua ở Úc và được thử nghiệm và tinh 

chỉnh bởi Lovell Racing và Huseman Engineering ở Hoa Kỳ. 

− 2023: Ranger tiếp tục phát triển 

Ford đã giới thiệu những cải tiến mới, chẳng hạn như Hệ thống giá đỡ linh hoạt và Hỗ 

trợ đánh lái trên đường off-road, để giúp khách hàng Ranger sử dụng xe tải của họ theo 

những cách mới và thú vị. 

1.2. Lý do chọn khung xe Ford Ranger 2021 

Khung xe Ford Ranger 2021 được lựa chọn làm đối tượng nghiên cứu vì độ cứng 

vững và bền bỉ đã được chứng minh qua nhiều thử nghiệm và phản hồi thực tế. Khung gầm 

của phiên bản này được thiết kế theo tiêu chuẩn Mỹ, với hơn 5.000 điểm hàn trên thân xe, 

đảm bảo khả năng chịu lực vượt trội và bảo vệ xe khỏi ăn mòn. Tuy nhiên, bất chấp những 

ưu điểm này, khung xe vẫn nhận được nhiều phản hồi không tốt từ người dùng về các vấn 

đề như nứt gãy hoặc biến dạng, đặc biệt trong điều kiện vận hành khắc nghiệt. Điều này 

tạo động lực để nghiên cứu sâu hơn, nhằm tìm ra nguyên nhân và đề xuất giải pháp cải 

tiến. 

 

1.3. Giới thiệu về mẫu xe bán tải Ford Ranger XTL 2021 
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Hình 2. 1: Ford Ranger XTL 2021 

Ford Ranger XLT 2021 bản 2.2L 4X4 MT gây ấn tượng mạnh mẽ đến khách hàng 

trong nước bởi ngoại hình vô cùng thể thao và hầm hố với kích thước tổng thể dài x rộng 

x cao lần lượt là 5362 x 1860 x 1830 mm. 

Không gian nội thất của Ranger XLT 2.2L 4X4 MT khá rộng rãi với chiều dài cơ 

sở đạt 3220 mm. Xe được tích hợp gương chiếu hậu trong với hai chế độ ngày và đêm 

nhằm cải thiện tầm quan sát của người lái.. 

Hệ thống điều hòa nhiệt độ trên Ranger XLT 2.2L 4X4 MT chỉ là loại chỉnh tay 

thông dụng, các thiết bị thông tin giải trí được Ford trang bị đầy đủ, cụ thể gồm có: đầu 

CD 1 đĩa, MP3, AM/FM, Ipod, USB, Bluetooth, dàn âm thanh 6 loa tạo ra những giai điệu 

sôi động. 

Dưới nắp capo của Ranger XLT 2.2L 4X4 MT là loại động cơ Turbo Diesel 2.2L i4 

TDCi, trục cam kép, có làm mát khí nạp sản sinh công suất tối đa 158 mã lực ở vòng tua 

3200 vòng/phút, mô men xoắn cực đại 385 Nm tại dải vòng tua 1600-2500 vòng/phút. 

Những chướng ngại vật trên đường khó có thể cản đường Ranger XLT 2.2L 4X4 

MT khi xe có gầm cao đến 200 mm. Ford Ranger XLT 2.2L 4X4 MT sử dụng bộ lốp dày 

có thông số  265/65R17 giúp giữ cho toàn bộ cơ thể chiếc xe trong trạng thái êm ái. 

Khả năng vận hành của xe được hỗ trợ đáng kể nhờ được trang bị hệ thống treo 

trước độc lập, tay đòn kép, lò xo trụ và ống giảm chấn, treo sau loại nhíp với ống giảm 

chấn kết hợp cùng phanh trước/sau dạng đĩa/tang trống. Ngoài ra, việc sử dụng tay lái trợ 

lực điện đã giúp việc đánh lái trở nên rất nhẹ nhàng. 

1.3. Thông số cơ bản của Ford Ranger XTL 2021 
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Bảng 2.1: Thông số cơ bản xe Ford Ranger XTL 2021 

Bảng 2. 1:Thông số cơ bản xe Ford Ranger XTL 2021 

STT HỆ THỐNG THÔNG SỐ 

Động cơ và tính năng vận hành 

1 Loại Cabin Cabin kép 

2 Động cơ Turbo Diesel 2,2L i4 TDCi 

3 Dung tích xylanh (cc) 2198 

4 Công suất cực đại (Ps/rpm) 160 (118kW)/3750 

5 Mô men xoắn cực đại(Nm/rpm) 385/1600-2500 

6 Tiêu chuẩn khí thải EURO 4 

7 Hệ thống truyền động Hai cầu chủ động 4x4 

8 Gài cầu điện Có 

9 Khóa vi sai cầu sau Có 

10 Hộp số Số sàn 6 cấp 

11 Trợ lực lái Trợ lực điện 

Kích thước và trọng lượng 

12 Dài x Rộng x Cao (mm) 5362 x 1860 x 1830 

13 Khoảng sáng gầm xe (mm) 200 

14 Chiều dài cơ sở (mm) 220 

15 Bản kính quay vòng tổi thiểu (mm) 6350 

16 Trọng lượng toàn bộ xe tiêu chuẩn 

(kg) 

3200 

17 Trọng lượng không tải xe tiêu chuẩn 

(kg) 

2015 

18 Tải trọng định mức xe tiêu chuẩn (kg) 824 

19 Góc thoát sau (độ) 20,9 

20 Kích thước thùng hàng (Dài x Rộng x 

Cao) 

1500 x 1560 / 1150 x 510 

Hệ thống treo 

21 Hệ thống treo trước Hệ thống treo độc lập, tay 

đòn kép, lò xo trụ và ống 

giảm chấn 

22 Hệ thống treo sau Nhíp với ống giảm chấn 

Hệ thống phanh 

23 Phanh trước Phanh đĩa 

24 Phanh sau Tang trống 

25 Cỡ lốp 265/65R17 

26 Bánh xe Vành hợp kim nhôm đúc 

17 

Trang thiết bị an toàn 

27 Túi khí phía trước Có 

28 Túi khí bên Không 

29 Túi khí rèm dọc 2 bên trần xe Không 

30 Camera lùi Không 
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31 Cảm biến hỗ trợ đỗ xe Cảm biến phía sau 

32 Hệ thống chống bó cứng phanh Có 

33 Hệ thống phân phối lực phanh điện tử Có 

34 Hệ thống cân bằng điện tử Không 

35 Hệ thống kiểm soát giảm thiếu lật xe Không 

36 Hệ thống kiểm soát xe theo tải trọng Không 

37 Hệ thống hỗ trợ khởi hành ngang dốc Không 

38 Hệ thống hỗ trợ đỗ đèo Không 

39 Hệ thống kiếm soát hành trình Cruise Control 

 

40 

Hệ thống hỗ trợ chuyển làn và duy trì 

làn đường 

Không 

41 Hệ thống cảnh báo va chạm trước Không 

42 Hệ thống hỗ trợ đỗ xe chủ động song 

song 

Không 

43 Hệ thống chống trộm Không 

Trang thiết bị ngoại thất 

 

44 

Cụm đèn phía trước Projector với khả năng tự 

động bật tất với cảm biến 

ảnh sáng 

45 Đèn chạy ban ngày Không 

46 Gạt mưa tự động Có 

46 Đèn sương mù Có 

48 Gương chiếu hậu ban ngày Điều chỉnh điện – Crom 

49 Bộ trang bị thể thao Không 

Trang thiết bị nội thất 

50 Khởi động bằng nút bấm Không 

51 Chìa khóa thông minh Không 

52 Điều hòa nhiệt độ Điều chỉnh tay 

53 Vật liệu ghế Nỉ cao cấp 

54 Tay lái Bọc da 

55 Ghế lái trước Chỉnh tay 6 hướng 

56 Ghế sau Ghế băng gấp được có tựa 

đầu 

57 Gương chiếu hậu trong Chỉnh tay 2 chế độ 

58 Cửa kính điều khiển điện Có 

 

59 

Hệ thống âm thanh AM/FM CD 1 đĩa, MP3, 

Tpod & USB, Blutooth, 6 

loa 

60 Hệ thống chống ồn chủ động Không 

61 Công nghệ giải trí SYNC Điều khiển bằng giọng nói 

62 Bản đồ dẫn đường Không 

63 Điều khiển âm thanh trên tay lái Có 
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2. Dạng hư hỏng của khung xe Ford Ranger XTL 2021 

Khung gầm ô tô là bộ phận nâng đỡ tất cả các bộ phận, linh kiện khác của xe. Đồng 

thời, đây cũng là bộ phận kết nối tất cả các bộ phận khác, tạo nên hình dáng tổng thể của 

một chiếc xe, cũng như đảm bảo độ chắc chắn, ổn định và an toàn khi xe hoạt động. 

Nguyên nhân gây ra hư hỏng khung gầm ô tô chủ yếu do các lực tác động từ bên 

ngoài như tai nạn, va chạm, chở quá tải trọng hoặc có thể bị gỉ sét, ăn mòn từ bên trong. 

Do đó, việc xác định những hư hỏng tiềm ẩn đối với khung gầm ô tô là điều quan trọng. 

2.1 Khung xe bị uốn cong không đều. 

Phần đầu xe được thiết kế để hấp thụ lực tác động khi va chạm. Do đó, đây là phần 

dễ bị cong vênh nhất của khung xe. Với một số bộ phận nhỏ, sự biến dạng, Nhưng nếu bỏ 

qua vấn đề này, đây có thể là nguyên nhân gây ra các thiệt hại lớn hơn sau này. 

 

Hình 2. 2: Khung xe bị cong vênh ảnh hưởng đến khả năng chịu lực của xe 

2.2. Nứt khung (Cracked Chassis) và biến dạng khung (Bent Frame Sections) 

• Một số trường hợp ghi nhận khung xe bị nứt, đặc biệt ở phía sau bánh sau. Nguyên 

nhân có thể do: 

− Chịu tải nặng thường xuyên 

− Sử dụng trong điều kiện địa hình khắc nghiệt 

− Chất lượng mối hàn không đảm bảo 

Các vết nứt này có thể ảnh hưởng đến độ cứng vững và an toàn của xe . 

− Khung xe có thể bị biến dạng hoặc cong vênh do: 

− Va chạm mạnh 

− Tải trọng vượt quá giới hạn thiết kế 
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− Sử dụng xe trong điều kiện không phù hợp 

Biến dạng khung có thể dẫn đến lệch hệ thống treo, mòn lốp không đều và giảm hiệu 

quả lái xe . 

  

Hình 2. 3: Trường hợp nứt gãy trên khung xe Ford Ranger 
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CHƯƠNG 3: KẾT CẤU KHUNG XE FORD RANGER XTL 2021 

 

1.Cấu trúc Ford Ranger XTL 2021 

Ford Ranger là một trong những dòng xe bán tải được ưa chuộng nhất trên thế giới 

nhờ khả năng vận hành mạnh mẽ, thiết kế hiện đại và đặc biệt là khung gầm chắc chắn. 

Khung xe Ford Ranger được thiết kế để đáp ứng các yêu cầu khắt khe về độ bền, chịu tải 

và khả năng off-road, giúp xe vận hành linh hoạt trên mọi địa hình. 

 

Hình 3. 1: Khung xe Ford Ranger XTL 2021 

Thiết kế khung xe Ford ranger khá khác biệt có thể nói chẳng mây liên quan đến 

những phiên bản trước đó. Sở hữu kích thước thân hình 5.398 x 2.180 x 1.873 mm (dài, 

rộng, cao), so với đàn anh đi trước khung xe ford ranger dài hơn khoảng 35 mm, rộng hơn 

150 mm, cao hơn 13mm. Chính điều này đã giúp ford ranger ghi điểm với khách hàng bởi 

làm không gian trở nên rộng rãi và thoải mái hơn. Toàn bộ khung gầm của ford ranger còn 

được làm từ thép cường độ cao, phần cản trước và cản sau cũng được thiết kế bằng loại 

thép chịu lực đảm bảo độ chắc chắn cũng như an toàn 

Đặc biệt hơn nữa, khung xe ford ranger được nâng độ cao gầm thêm 83 mm cũng 

như cải tiến khả năng offroad. Các thông số về góc cũng có sự thay đối cụ thế là góc tới 

32,5 độ; góc vượt dốc là 24 độ và cuối cùng là góc thoát 24 độ mang đến cảm giác mạnh 

mẽ hơn. Không chỉ có vậy thiết hệ thống giảm chấn của Ranger cũng có sự thay đổi là loại 

độc lập cả bốn bánh với liên kết đa điểm kết hợp với lò xo. Chính sự thay đối này giúp 

khung xe ford ranger tăng khả năng thích ứng với mọi loại địa hình từ đồng bằng dễ đi cho 

đến hiểm trở trơn trượt. Với những ưu điểm nổi bật trên có thể nói khung xe ford ranger 
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làm hài lòng bất cứ vị khách hàng. Nếu bạn đang muốn sở hữu một chiếc xe bán tải với 

khung gầm chắc chắn, mạnh mẽ và an toàn thì đừng bỏ qua ford ranger 

Ford Ranger sử dụng thiết kế khung gầm rời dạng hình thang (Ladder Frame), giúp 

xe có khả năng chịu tải tốt hơn so với các dòng xe sử dụng khung liền khối (Unibody). Cấu 

trúc này bao gồm: 

− Các dầm dọc: Chạy dọc theo chiều dài xe, giúp tăng độ cứng vững cho khung. 

− Các thanh ngang gia cố: Kết nối các dầm dọc, tạo sự ổn định và tăng khả năng chống 

xoắn. 

− Kết cấu gia cường tại các điểm trọng yếu: Nhằm tối ưu hóa khả năng chịu tải và hấp 

thụ lực khi xe di chuyển trên địa hình gồ ghề. 

1.1.Nhiệm vụ của khung xe ford Ranger 

− Nâng đỡ và liên kết các bộ phận chính. 

+Khung xe đóng vai trò như xương sống của toàn bộ kết cấu ô tô. 

+Trên khung xe, các hệ thống quan trọng như động cơ, hộp số, hệ thống truyền động, 

hệ thống treo, thân xe, hệ thống lái, hệ thống phanh... đều được gắn trực tiếp hoặc gián 

tiếp. 

+Thiết kế khung phải đảm bảo vị trí và liên kết chính xác giữa các cụm hệ thống, đảm 

bảo sự đồng bộ về hoạt động. 

− Chịu tải và chịu áp lực: 

Khi xe vận hành, khung xe chịu đồng thời: Tải trọng tĩnh (trọng lượng bản thân xe, 

hành khách, hàng hóa).Tải trọng động (lực quán tính khi tăng tốc, lực ly tâm khi vào 

cua, lực phanh khi giảm tốc...). Khung xe phải phân phối tải trọng đều đến hệ thống 

treo, từ đó giúp xe vận hành ổn định, không bị rung lắc hoặc vặn xoắn quá mức. 

− Tạo độ cứng vững và ổn định cho xe: 

+Một khung xe tốt cần có độ bền tĩnh và độ bền động cao để chống lại biến dạng dưới 

tác dụng lâu dài của tải trọng.Nếu khung quá mềm, xe dễ bị rung, lắc và ảnh hưởng đến 

hệ thống treo, gây khó khăn trong điều khiển. 

+Nếu khung quá cứng mà không có vùng đàn hồi, có thể làm tăng chấn động truyền 

vào khoang hành khách.Các nhà sản xuất như Ford thiết kế khung xe với sự cân bằng 

giữa độ cứng và khả năng hấp thụ xung lực, tùy thuộc vào mục đích sử dụng của xe (ví 

dụ: Ranger có thể dùng khung dạng hộp kín ở các đoạn chịu lực lớn để tăng cứng). 
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+.Đảm bảo an toàn cho người ngồi trong xe: 

+Trong va chạm, khung xe giúp hấp thụ và phân tán lực va chạm ra nhiều hướng, giảm 

xung lực trực tiếp lên khoang hành khách. 

+Các vùng khung phía trước và sau thường được thiết kế với vùng biến dạng có kiểm 

soát (crumple zones) – mục tiêu là biến dạng để bảo vệ, không phải giữ nguyên. 

+Tiêu chuẩn an toàn: Khung xe phải đáp ứng các tiêu chuẩn như NCAP, FMVSS, hay 

UNECE. 

Ngoài ra, khung còn được kiểm nghiệm với các mô phỏng va chạm (Crash Test 

Simulation) bằng phần mềm CAE. 

1.2. Ưu điểm khung xe ford Ranger XTL 2021  

− Độ bền cao: 

Khung gầm của Ford Ranger được thiết kế để chịu được tải trọng lớn, phù hợp với các 

nhu cầu chở hàng, kéo moóc hoặc di chuyển trên các cung đường khó khăn. 

− Khả năng off-road vượt trội: 

Nhờ thiết kế body-on-frame và khoảng sáng gầm xe cao, Ford Ranger có thể dễ dàng 

vượt qua các địa hình gồ ghề, bùn lầy hoặc đường sỏi đá mà không làm ảnh hưởng đến 

khung xe. 

− Cải thiện độ an toàn: 

Khung xe được thiết kế để hấp thụ và phân tán lực va chạm, giúp bảo vệ tối đa hành 

khách trong các tình huống khẩn cấp. Ngoài ra, các thanh gia cố giúp giảm thiểu độ biến 

dạng của khoang cabin khi có va chạm mạnh. 

2. Số liệu của các cụm tổng thành lắp lên khung xe 
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Hình 3. 222: Kích thước cơ bản khung xe Ford Ranger XTL 2021 

 

 

Bảng 3. 1: Thông số kỹ thuật khung xe Ford Ranger 

STT Thông số kỹ thuật Giá trị 

1 Chiều dài chassis 4470mm 

2 Chiều rộng chassis 1370mm 

3 Chiều dài cơ sở 3220mm 

4 Trọng lượng chassis 2015kg 

5 Trọng lượng toàn bộ 3200 kg 
 

− Chiều dài Chassis: 4470mm 

Đây là chiều dài toàn bộ khung chính (khung rời), không bao gồm phần thân xe gắn lên 

trên. Kích thước này cho thấy Ford Ranger có khung khá dài, phù hợp với tải trọng lớn và 

cabin kép. 

− Chiều rộng Chassis: 1370mm 

Là khoảng cách giữa hai dầm chính khung xe. Độ rộng vừa phải giúp đảm bảo tính ổn định 

khi xe vận hành và dễ dàng tích hợp các hệ thống treo, cầu, động cơ. 

− Chiều dài cơ sở: 3220mm 

Là khoảng cách giữa trục bánh trước và bánh sau, ảnh hưởng đến khả năng điều khiển 

và độ ổn định của xe. Cơ sở dài mang lại không gian nội thất rộng hơn và cải thiện độ ổn 

định trên đường trường. 
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Trọng lượng toàn bộ: bao gồm khung + thân vỏ + hệ thống truyền động + dầu mỡ 

+ người và hàng hoá theo thiết kế. Ford Ranger XTL là một mẫu bán tải cỡ trung với sức 

chịu tải tốt, phù hợp cả cho vận tải và off-road. 

Thiết kế dầm chính dạng hộp kín tại các khu vực chịu tải lớn giúp gia tăng độ bền và độ 

cứng xoắn. Khoảng cách giữa các thanh giằng ngang được bố trí hợp lý, tăng độ ổn định 

tổng thể của khung. 

Vùng đầu và đuôi chassis có thiết kế uốn cong, đây là khu vực có vùng biến dạng 

có kiểm soát (crumple zones) hỗ trợ giảm xung lực va chạm. Chiều cao khung tại vị trí 

gầm xe là 270 mm, cho thấy khung được nâng cao để phù hợp với khả năng vượt địa hình. 

 

2.1. Dầm dọc 

 

  

 

Dầm dọc,Chịu tải chính của xe, kết nối với hệ thống treo tại trục trước và trục sau. Đảm 

bảo độ cứng dọc (longitudinal stiffness) và độ cứng xoắn (torsional stiffness) của khung.  

Truyền lực từ trục trước đến trục sau qua các mối hàn và thanh ngang. Các đoạn 

cong và độ cao thay đổi cho phép dầm dọc uốn cong một cách kiểm soát khi gặp va chạm 

hoặc tải trọng lớn, bảo vệ các bộ phận khác của xe. Độ dài và hình dạng liên tục (từ đầu 

đến cuối) giúp duy trì sự ổn định tổng thể của khung. 

2.2. Dầm ngang. 

Hình 3. 3: Cấu trúc dầm dọc 
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Hình 3. 4: Thanh dầm ngang 1 

 

Hình 3. 5: Thanh dầm ngang 2 

 

Hình 3. 6: Thanh dầm ngang 3 
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Dầm ngang không chỉ là một bộ phận kết nối đơn thuần mà còn là yếu tố cốt lõi 

trong việc đảm bảo tính toàn vẹn cấu trúc của khung xe Ford Ranger. Nó góp phần lớn vào 

khả năng chịu tải, ổn định, và hiệu suất tổng thể của xe, đặc biệt trong các tình huống đòi 

hỏi độ bền cao. 

Dầm ngang được thiết kế để bổ sung độ cứng ngang và hỗ trợ phân bố lực, rất quan 

trọng cho xe bán tải như Ford Ranger khi hoạt động trên địa hình phức tạp.dầm ngang hỗ 

trợ phân bố lực ngang từ các dầm dọc, giảm áp lực lên các điểm kết nối như trục hoặc treo, 

đảm bảo sự ổn định khi xe tăng tốc, phanh hoặc quay đầu. 

Thiết kế của dầm ngang phản ánh sự cân nhắc kỹ lưỡng về nhu cầu thực tế của một 

chiếc xe bán tải: vừa phải mạnh mẽ để chở hàng nặng, vừa phải linh hoạt để thích nghi với 

các điều kiện vận hành đa dạng. 

2.3. Giá đỡ nhíp 

 

Hình 3. 7: Giá đỡ nhíp 

Giá đỡ nhíp là bộ phận trung gian kết nối hệ thống treo nhíp (leaf spring) với dầm 

dọc của khung xe. Nó đảm bảo nhíp được cố định chắc chắn, cho phép hệ thống treo hoạt 

động hiệu quả trong việc hấp thụ chấn động từ mặt đường.  

Nhiệm vụ chính là truyền lực từ nhíp lên khung xe một cách ổn định, đặc biệt khi 

xe chịu tải nặng hoặc di chuyển trên địa hình gồ ghề. 

Khi xe vận hành, nhíp sẽ chịu lực nén và uốn từ các dao động của bánh xe. Giá đỡ 

nhíp giúp phân tán lực này lên khung xe, giảm áp lực tập trung tại một điểm duy nhất, từ 

đó bảo vệ cả nhíp và khung xe khỏi hư hỏng. 

2.4. Giá đỡ giảm chấn 
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Hình 3. 8: Giá đỡ giảm chấn 

Giá đỡ giảm chấn (shock absorber mount) là bộ phận quan trọng trong hệ thống treo 

của xe, bao gồm cả Ford Ranger, nhằm giảm thiểu rung động và va đập từ mặt đường 

truyền lên khung xe và cabin. Nguyên lý hoạt động dựa trên việc hấp thụ và tiêu tán năng 

lượng động học thông qua các cơ chế như ma sát, nén chất lỏng hoặc khí nén: 

− Hấp thụ năng lượng: Giá đỡ giảm chấn thường kết hợp với bộ giảm chấn (shock 

absorber), sử dụng piston di chuyển trong xi lanh chứa dầu hoặc khí để chuyển đổi 

năng lượng rung động thành nhiệt năng, từ đó giảm độ dao động.  

− Kết nối khung xe: Giá đỡ được gắn trực tiếp vào khung và hệ thống treo, đảm bảo 

truyền tải lực một cách ổn định, đồng thời bảo vệ các bộ phận khác khỏi hư hỏng. 

Formatted: Font: (Default) Times New Roman, 13 pt

Formatted: Justified, Indent: First line:  1,27 cm, Space
Before:  0 pt, After:  10 pt, Line spacing:  Multiple 1,2 li

Formatted: Font: (Default) Times New Roman, 13 pt, Not
Bold
Formatted: List Paragraph, Justified, Line spacing:  Multiple
1,2 li, Bulleted + Level: 1 + Aligned at:  0,63 cm + Indent at:
 1,27 cm

Formatted: Font: (Default) Times New Roman, 13 pt

Formatted: Font: (Default) Times New Roman, 13 pt, Not
Bold
Formatted: List Paragraph, Justified, Space Before:  0 pt,
After:  0 pt, Line spacing:  Multiple 1,2 li, Bulleted + Level: 1
+ Aligned at:  0,63 cm + Indent at:  1,27 cm

Formatted: Font: (Default) Times New Roman, 13 pt

Formatted: Normal, Centered



Tính toán kiểm nghiệm khung xe ô tô Ford Ranger 

 

 

Sinh viên thực hiện: Nguyễn Hoàng Ý 20 Hướng dẫn: TS. Phan Mình Đức 

Formatted: Font: (Default) Times New Roman, 12 pt, Italic

Formatted: Centered

Formatted: Font: (Default) Times New Roman

Formatted: Font: (Default) Times New Roman

CHƯƠNG 4: CÁC CHẾ ĐỘ TÍNH TOÁN KHUNG XE 

 

1.Giới thiệu các chế độ tính toán khung xe 

Điều kiện địa hình có ảnh hưởng trực tiếp đến độ bền của thân xe. Khi xe di chuyển 

trên các loại địa hình khác nhau sẽ xuất hiện các lực khác nhau tác động lên hệ thống treo 

và truyền trực tiếp lên thân xe. Các lực này thay đổi tùy thuộc vào cường độ thay đổi của 

gia tốc tức thời. Các hệ số gia tốc tức thời được xác định thông qua quá trình thử 

nghiệm thực tế, từ đó thiết lập các tiêu chuẩn để áp dụng vào tính toán thiết kế thân xe Ford 

Ranger. Thân xe Ford Ranger khi thiết kế cần thỏa mãn các điều kiện làm việc. 

2.Xây dựng mô hình tính toán cho từng chế độ làm việc 

Dựa vào TL [13] của Thầy Phan Minh Đức và Thầy Lê Công Tín ta có thể đưa ra 

các điều kiện phân tích độ bên trên khung xe Ford Ranger. 

Bảng 4. 1: Xây dựng mô mình tính toán  cho từng chế độ làm việc 

STT  Trường hợp mô phỏng Hình ảnh minh hoạ phản lực tác động 

 

 

1 

 

 

 

Bánh xe bị sụp hố 

(Uốn 2G) 

 

 

 

 

2 

 

 

Bánh xe quay vòng 

(QV-0,5G) 

 

 

 

 

3 

 

 

Xe phanh gấp 

(Phanh khi tiến-0,8G) 
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3.Toạ độ trọng tâm xe, cabin, thùng xe. 

3.1.Toạ độ trọng tâm của xe 

− Trọng lượng không tải của Ford Ranger: 
0

G =3200 (kg) 

− Trọng lượng thùng chở hàng và hàng hoá trên thùng: 
2

G =1300 (kg) 

− Xác định toạ độ trọng tâm của ô tô Ford Ranger theo chiều dọc của xe  

Ta có công thức xác định toạ độ trọng tâm X của n vật có khối lượng 
i

m  và toạ độ 

i
x như sau: 

1

1

.
( )

n

i i
i

n

i

x m
X mm

G

=

=

=



 

Trong trường hợp này ta chọn gốc toạ độ O tại vị trí giữa bánh xe và mặt đường khi 

đó ta có giá trị sau: 

1
x =0[mm]  ,

2
x =

1
L =3220[mm]  

1
m =1590(kg), 

2
1610( )m kg=  

Vậy: Toạ độ trọng tâm của ôtô satxi tải Ford Ranger theo chiều dọc của xe có 

giá trị là: 

1 1 2
. .x m x m

X
G

+
=  

0.1595 3220.1605
1200( )

3200
X mm

+
= =  

Vậy X=1200 (mm) 

Đề cho chiều dài, rộng, cao của thùng xe lần lượt là DxRxC: 1500x1150x550 

Giả sử thùng xe là hình hộp chữ nhật và gốc toạ độ đặt ở trục trước 

Vậy toạ độ trung tâm tương đối trong hệ toạ độ riêng của hình hộp chữ nhật: 

Vị trí bắt đầu gắn thùng xe đến gốc toạ độ 
g

x =2600 (mm) 
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th
x =

1500
750( )

2 2

L
mm= =  

th
y =

1150
575( )

2 2

R
mm= =  

th
z =

550
225( )

2 2

C
mm= =  

Khoảng cách từ toạ độ trọng tâm đến gốc toạ độ là: 

tdthung
x =

th
x +

g
x =2600+750=3350 (mm) 
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CHƯƠNG 5: PHƯƠNG PHÁP TÍNH TOÁN PHẦN TỬ HỮU HẠN 

VÀ PHẦN MỀM MÔ PHỎNG. 

 

1.Giới thiệu phương pháp phần tử hữu hạn trong phân tích kết cấu 

 Sự tiền bộ của khoa học, kỹ thuật đòi hỏi người kỹ sư thực hiện những đề án ngày 

càng phức tạp, đắt tiền và đòi hỏi độ chính xác, an toàn cao. 

Phương pháp phần tử hữu hạn (PTHH) là một phương pháp rất tổng quát và hữu 

hiệu cho lời giải số nhiều lớp bài toán kỹ thuật khác nhau. Từ việc phân tích trạng thái ứng 

suất, biến dạng trong các kết cấu cơ khí, các chi tiết trong ô tô, máy bay, tàu thủỷ, khung 

nhà cao tầng, dầm cầu, v.v, đến những bài toán của lý thuyết trường như: lý thuyết truyền 

nhiệt, cơ học chất lỏng, thủỷ đàn hồi, khí đàn hôi, điện-từ trường v.v. Với sự trợ giúp của 

ngành Công nghệ thông tin và hệ thống CAD, nhiều kết cấu phức tạp cũng đã được tính 

toán và thiết kể chi tiết một cách dễ dàng. Trên thế giới có nhiều phần mềm PTHH nổi 

tiếng như: HYPERWORK, NASTRAN, ANSYS, TITUS, MODULEF, SAP 2000, 

CASTEM 2000, SAMCEF v.v.  

 Để có thể khai thác hiệu quả những phần mềm PTHH hiện có hoặc tự xây dựng lấy 

một chương trình tính toán bằng PTHH, ta cần phải nắm được cơ sở lý thuyết, kỹ thuật mô 

hình hóa cũng như các bước tính cơ bản của phương pháp. 

1.1. Qui tắc chia miền thành các phần tử 

Việc chia miền V thành các phần tử 
ev phải thoa mãn hai qui tắc sau: Hai phần tử 

khác nhau chỉ có thể có những điểm chung nằm trên biên của chúng. Điều này loại trừ khả 

năng giao nhau giữa hai phần tử. Biên giới giữa các phần tử có thể là các điểm, đường hay 

mặt Tập hợp tất cả các phần tử 
ev phải tạo thành một miền càng gần với miền V cho trước 

càng tốt. Tránh không được tạo lỗ hổng giữa các phần tử 

 

Hình 5. 1: Các dạng biên dạng chung giữa các phần tử 

1.2. Các dạng phần tử hữu hạn. 
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 Có nhiều dạng phần tử hữu hạn: phần tử một chiều, hai chiều và ba chiều. Trong 

mỗi dạng đó, đại lượng khảo sát có thể biến thiên bậc nhất (gọi là phần tử bậc nhất), bậc 

hai hoặc bậc ba v.v. Dưới đây, chúng ta làm quen với một số dạng phần tử hữu hạn hay 

gặp. 

− Phần tử một chiều 

 

− Phần tử hai chiều 

 

− Phần tử ba chiều 

Phần tử tứ diện 

 

− Phần tử lăng trụ 
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2.Tổng quan về phần mềm Hyperwoks và ứng dụng trong mô phỏng kết cấu khung 

xe. 

2.1.Giới thiệu về phần mềm Hyperwork 

Hyperworks là một trong những phần mềm CAE nổi tiếng và được ứng dụng trong 

nhiều lĩnh vực với khả năng phân tích chính xác dựa trên phương pháp phần tử hữu hạn. 

Hyperworks giúp các doanh nghiệp các trung tâm nghiên cứu nâng cao chất lượng, giảm 

chi phí, nâng cao năng suất. Giúp tối ưu hóa quá trình thiết kế và sản xuất. 

Hyperworks cung cấp giải pháp toàm diện nhất mở ra giải pháp CAE trong nền công 

nghiệp, bao gồm cả mô phỏng phân tích, quản lý dữ liệu tuyến tính và phi tuyến, tối ưu 

hoá cấu trúc, cấu trúc chất lỏng, sự tương tác giữa các vật thể, và nhiều ứng dụng đối với 

các cơ cấu. 

2.2.Công dụng của phần mềm Hyperwork 

Phần mềm Hyperworks là một trong những phần mềm phân tích CAE nổi tiếng và 

được ứng dụng trong nhiều lĩnh vực với khả năng phân tích chính xác dựa trên phương 

pháp phân tích phần tử hữu hạn. Phần mềm Hyperworks giúp các doanh nghiệp các trung 

tâm nghiên cứu nâng cao chất lượng, giảm chi phí, nâng cao năng suất. Ứng dụng phần 

mềm hyperwork vào tính toán, kiểm bền chi tiết cánh cửa trên ô tô. 

HyperWorks là nền tảng mô phỏng có kiến trúc mở toàn diện nhất cung cấp các 

công nghệ hàng đầu để thiết kế và tối ưu các sản phẩm một cách sáng tạo và có hiệu quả. 

HyperWorks bao gồm các công cụ mô hình hóa phần tử hữu hạn, phân tích và tối ưu hóa 

các cấu trúc, lưu chất, hệ đa vật thể, điện từ và vị trí ăng-ten, phát triển các mô hình 

cơ sở, phân tích các hệ đa môi trường [4]. Phần mềm HyperWorks được sử dụng rộng rãi 

với các mô-đun chính: Hypermesh, Motionsolve, Radioss, Optistruct, Hypergraph. Quy 

trình tính toán được mô tả tổng quát như sơ đồ được thể hiện trong Hình 

2.3. Giới thiệu về Hypermesh. 

 

Hình 5. 2: Bộ công cụ mô hình hoá Hypermesh 

 

Formatted: Space Before:  0 pt, After:  0 pt, Line spacing: 
1,5 lines

Formatted: Font: 11 pt

Formatted: Normal



Tính toán kiểm nghiệm khung xe ô tô Ford Ranger 

 

 

Sinh viên thực hiện: Nguyễn Hoàng Ý 26 Hướng dẫn: TS. Phan Mình Đức 

Formatted: Font: (Default) Times New Roman, 12 pt, Italic

Formatted: Centered

Formatted: Font: (Default) Times New Roman

Formatted: Font: (Default) Times New Roman

HyperMesh là bộ tiền xử lý tiên tiến hàng đầu dành cho quá trình mô hình hóa có 

độ trung thực cao. Khả năng tạo lưới nhanh chóng và chất lượng chính là điểm cốt lõi của 

HyperMesh. Giải pháp mô hình hóa này cung cấp các công cụ lắp ráp mô hình tiên tiến hỗ 

trợ việc tạo và lắp ráp các mô hình phức tạp, ngoài ra việc mô phỏng các  chi tiết đa vật 

liệu được hỗ trợ bởi các công cụ tạo, chỉnh sửa và hiển thị nâng cao. Quá trình thay đổi 

thiết kế được thực hiện thông qua mô hình lưới và biến đổi hình học. 

HyperMesh được hàng ngàn khách hàng trên thế giới sử dụng để tạo và quản lý mô 

hình của họ, với khả năng tương thích với các phần mềm CAD phổ biến hiện nay và hỗ trợ 

các phần mềm CAE khác làm cho nó trở thành một giải pháp hoàn hảo cho phần lớn các 

ngành và lĩnh vực 

2.3.1. Điểm nổi bật của sản phẩm 

− Thuật toán tạo lưới 2D và lưới 3D liền mạch, tạo và kiểm soát lưới tự động hoặc  thủ 

công. 

−  Tương tác tốt với các phần mềm CAD.  

−  Hỗ trợ các mô hình đa vật liệu – Vật liệu composite.  

− Tương thích với các bộ giải phổ biến hiện nay. 

−  Quản lý các cụm chi tiết phức tạp thúc đẩy xây dựng mô hình chung. 

2.3.2. Lợi ích của Hypermesh  

− Kiến trúc thiết kế mở :Giao diện người dùng tương thích với các phần mềm CAD 

và CAE hiện nay, HyperMesh phù hợp với bất kỳ môi trường mô phỏng nào. 

− Tạo lưới chất lượng cao và nhanh chóng :Cung cấp một bộ công cụ để tạo mô hình 

lưới từ đơn giản đến phức tạp, hỗ trợ các công cụ tạo và hiệu chỉnh lưới tự động 

hoặc thủ công.  

− Xây dựng mô hình và lắp ghép: Giải pháp quản lý mô hình chi tiết và mô hình lắp 

ghép liên kết hai chiều tới PDM cho phép nhập hoặc xuất dữ liệu một cách liền 

mạch, tạo điều kiện cho sự tương tác giữa các nhóm trong và ngoài nước. 

2.3.3.Tính năng tạo lưới HyperMesh 

Hypermesh có một công cụ dể sử dụng để xây dựng và chỉnh sửa các mô hình CAE. 

Đối với việc tạo các mô hình 2D và 3D, người dùng có quyền truy cập vào các tính năng 

tạo lưới cũng như mô-đun tạo lưới tự động mạnh mẽ của HyperMesh.  

− Lưới ứng dụng  

− Lưới phủ bề mặt.  

− Lưới dạng khối.  

− Lưới tetra Lưới CFD cho mô phỏng lưu chất 

− Tạo lưới mô phỏng âm học 

− Tạo lưới Shrink wrap Lưới SPH  

− Lưới bề mặt  
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2.3.4. Khả năng tương tác 

  CAD HyperMesh có các trình đọc trực tiếp các định dạng CAD phổ biến hiện nay 

như ACIS, CATIA V4/V5/V6, IGES, Inspire, Intergraph, JT, PARASOLID, PTC Creo, 

SolidWorks, STEP, Tribon, NX, các công cụ để hiệu chỉnh hình học về lỗi như khe hở, các 

bề mặt chồng chéo nhau gây sai lêch cho quá trình tạo lưới chất lượng cao. 

2.3.5. Tùy chỉnh trong HyperMesh  

Tùy chỉnh các thanh công cụ thông qua giao diện kéo thả dễ sử dụng, hiệu chỉnh các 

phím tắt. Tạo các ứng dụng tùy chỉnh được tích hợp hoàn toàn trong HyperMesh. Trình 

biên dịch đầu vào các bộ giải khác nhau: Người dùng có thể mở rộng giao diện hỗ trợ của 

HyperMesh bằng cách thêm các trình dịch đầu vào để đọc các dữ liệu phân tích khác nhau. 

Trích xuất ra các bộ giải: HyperMesh cho phép xuất dữ liệu sang các định dạng khác nhau 

cho các bộ giải tương ứng. 

2.3.6. Tương tác các bộ giải CAE  

HyperMesh cung cấp các công cụ hỗ trợ nhập và xuất trực tiếp các bộ giải CAE phổ 

biến hiện nay như Abaqus, Actran, Acusolve, Adams, Ansys, CFD , Moldex3D, Moldflow, 

Motionsolve, Nastran MSC, Nastran NX, Optistruct, Pam-Crash, Radioss, Samcef, 

Simpack, StarCD, LS-DYNA, Madyno, Marc, Fluent. 

2.4. Giao diện, thao tác cơ bản Hyperworks  

 

Hình 5. 3: Giao diện ban đầu Hypermesh 
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2.4.1. User profile 

 

Hình 5. 4:User Profile 

Mở và lưu file trong Hypermesh 

: Tạo 1 file mới 

:Mở 1 file có sẵn 

:Lưu file 

:Nhập 1 file từ bên ngoài vào môi trường Hypermesh 

  : Nhập một file Hypermesh 

  :nhập 1 file FE 

  :Nhập 1 file hình học 

  : Nhập 1 file Connectors 

: xuất file ra các định dạng file khác 

:Mở 1 cửa sổ User Profile 
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2.4.2. Các Panel lệnh trong HyperMesh 

Hầu hết các chức năng làm việc trong HyperMesh(HM) được tập trung tại các panel. 

Vùng panel được chia làm 7 trang, và trên mỗi trang là những panel cho phép sử dụng tất 

cả các chức năng của module HM. Hầu hết tất cả các thông tin liên quan đến việc chia lưới 

đối tượng đều được đưa vào tại vùng panel 

− Panel Layout: 

Trong HM có 3 loại Layout 

+Panel cơ bản 

 

Hình 5. 5:Panel có panel con bên trong 

 

Hình 5. 6:Panel chứ các panel con và thêm một số tuỳ chọn khác 

 

Hình 5. 7: Hình Các công cụ trong lệnh panel 

− Trong panel lệnh có nhiều nút nhấn và tuỳ chọn, 

+Swiches- : khi kích nút Switches, 1 cửa sổ pop-up xuất hiện, chọn 1 trong nhiều 

tuỳ chọn 

+Toggles- : chọn 1 trong 2 tuỳ chọn có sẵn 

+Reset- : huỷ bỏ lựa chọn 

+ :Tuỳ chọn mở rộng. Khi nhấn vào nút màu vàng. 1 cửa sổ lựa 

chọn mở rộng xuất hiện cung cấp các công cụ nâng cao hỗ trợ cho việc chọn các đối 

tượng: 
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− Công cụ chọn đối tượng và mặt phẳng 

X,Y,Z Axis  

 

N1,N2,N3:  

− Chọn 2 node (N1 và N2) để xác định chiều từ N1 đến N2 

−  

 

 

− Chọn 3 node (N1,N2 và N3) để xác định mặt phẳng đi qua 3 điểm, chiều dương 

vuông góc mặt phẳng tuân theo quy tắc bàn tay phải. 

−  
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2.4.3. Các chế độ hiển thị 

− Element: 

 

Hình 5. 8: Chế độ xe Element 

2.4.4. Geometry (Mô hình hình học) 

 

− Thanh công cụ Mask  

Được dùng để làm hiện lên hay ẩn đi các đối tượng được chọn 

− MARK: ẩn các đối tượng được chọn 

− REVERSE: đảo chiều hiển thị giữa các đối tưởng nằm kế cận  

− UNMARK ADJACENT: làm hiện lên các đối tượng nằm kế cận 

− UNMASK ALL: hiện lên cac đối tượng đang ẩn 

− MASK NOT SHOWN: ẩn các đối tượng ngoài vùng quan sát 

−  SPHERICAL CLIPPING: chỉ thực hiện được trong vùng được chọn 

− FIND: tìm các đối tượng 

−  DISPLAY NUMBER: hiển thị số thứ tự của phần tử 

− DISPLAY ELEMENT HANDLES: hiển thị phần tử 

− DISPLAY LOAD HANDLES: hiển thị kí hiệu điều kiện biên 

− DISPLAY FIXED POINTS-hiển thị các điểm cố định 

− Model Browse 
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Hình 5. 9: Công cụ để điều khiển các chế độ hiển thị mô hình 

+Hiển thị mô hình (Geometry) hay phần tử Element 

+Thay đổi màu sắc (click chuột phải) 

+Thay đổi các chế độ hiển thị của mô hình (click chuột phải) 

− Sắp xếp dữ liệu trong HyperMesh  

Trong HM, các dữ liệu khác nhau (như mô hình, vật liệu, các tải trọng,…) sẽ được đặt 

trong các nhóm khác nhau để tạo ra sự đơn giản trong việc quản lí các dữ liệu. Trong phần 

mềm HM, các nhóm khác nhau được gọi là các Collectors.  

− Collectors 

HyperMesh có 10 loại collectors khác nhau:  

+Component: chứa đựng mô hình và các phần tử   

+Multibody: Ellipsoids, Mbjoints, Mbplanes và các cảm biến  

+Assembly: chứa 1 hay nhiều mô hình hay nhiều mô hình lắp ráp  

+Load: chứa các điều kiện về tải trọng và rang buộc  

+Property:xác định các đặc tính được gán cho mô hình hay phần tử  

+Material: xác định vật liệu của Property Collectors  

+System: chứa các hệ thống được thiết lập bởi người sử dụng  

+Vector: chứa các vectơ  

+Beam Section: tiết diện cắt ngang của dầm 
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− Một số phương pháp để tạo Collectors: 

+Model Browser 

Nhấn cuột ở vùng trống của model Browser→Create→chọn Collectors để tạo. Ngoài 

ra, còn có thể chỉnh sửa, đổi tên, thay đổi số ID, màu sắc hoặc có thể xoá bỏ các Collectors 

đã được tạo 

 

Hình 5. 10: Pull Down Menus 

Từ Pull Down Menus→Collectors→Create→chọn Collectors 
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Hình 5. 11: Icon Toolbars 

 

Hình 5. 11: Icon Toolbars 

 

Củng có thể tạo các Colectors bằng cách sử dụng các icon trên thanh công cụ 

Collectors: 

 

3. Quy trình mô phỏng trên Hyperworks. 
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Hình 5. 12Quy trình thực hiện mô phỏng trên Hyperworks 

3.1. Nhập và chỉnh sửa mô hình – Khâu nền tảng của mô phỏng 

  Ở bước đầu tiên, mô hình 3D của đối tượng (trong hình là một vệ tinh) được nhập 

vào HyperWorks.  

Mô hình này có thể được tạo từ phần mềm CAD (như CATIA, SolidWorks) và sau 

đó được chỉnh sửa trong HyperWorks để đảm bảo hình học phù hợp cho mô phỏng. Các 

chỉnh sửa có thể bao gồm làm sạch hình học (loại bỏ lỗi), đơn giản hóa mô hình, hoặc thêm 

các đặc tính cần thiết. 

Chuẩn hóa đơn vị, tọa độ và cấu trúc mô hình: cần đảm bảo tính nhất quán về hệ tọa 

độ, đơn vị và các bề mặt tiếp xúc.Việc làm sạch và chỉnh sửa mô hình không chỉ để “đẹp” 

mà là để đảm bảo tính khả thi của rời rạc hóa và tính đúng đắn của mô hình phần tử hữu 

hạn. Một mô hình chưa được xử lý hình học sẽ dễ gây lỗi solver hoặc chia lưới phi vật lý. 

3.2. Xây dựng bài toán  

Sau khi chỉnh sửa hình học, mô hình được chia lưới (meshing) để tạo ra các phần tử 

hữu hạn (finite elements). Trong hình, vệ tinh đã được chia thành lưới 3D, thường là lưới 

tứ diện hoặc lục diện, để chuẩn bị cho phân tích. . 

Giai đoạn này biến mô hình hình học thành mô hình toán học có thể giải bằng máy tính. 

Bao gồm: 

− Gán vật liệu (đẳng hướng, dị hướng, phi tuyến...) 

− Gán điều kiện biên (gối, liên kết, trượt...) 

− Gán tải trọng (tĩnh, động, nhiệt...) 

− Chia lưới (mesh) 
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Đây là giai đoạn quan trọng để chuyển đổi bài toán vật lý sang dạng rời rạc, yêu cầu 

người kỹ sư phải hiểu sâu về ứng xử cơ học của kết cấu và quy luật vật lý chi phối. Một 

mô hình phần tử hữu hạn tốt không chỉ dựa vào số lượng phần tử mà còn vào chất lượng 

lưới, loại phần tử phù hợp và chiến lược mô hình hóa hiệu quả. 

3.3. Giải bài toán  

  Sau khi chạy mô phỏng, kết quả được phân tích. Trong hình, kết quả được hiển thị 

dưới dạng bản đồ màu (contour plot) trên mô hình vệ tinh, cho thấy sự phân bố của một 

đại lượng vật lý (có thể là ứng suất, biến dạng, hoặc nhiệt độ).Các vùng màu đỏ và xanh 

biểu thị giá trị cao và thấp của đại lượng được phân tích. 

Giai đoạn này thể hiện sức mạnh tính toán của HyperWorks, nhưng máy tính không 

“tự thông minh”. Kỹ sư mô phỏng phải chọn đúng loại bài toán, solver thích hợp và kiểm 

soát quy trình hội tụ, bởi nếu không, dù có mô hình đẹp và chia lưới tốt, kết quả vẫn vô 

dụng. 

3.4. Đánh giá kết quả – Biến dữ liệu thành thông tin kỹ thuật 

Dữ liệu thô từ solver (ứng suất, biến dạng, chuyển vị, tần số...) được xử lý thành kết 

quả trực quan bằng đồ thị, biểu đồ màu (contour plot), bản đồ ứng suất… 

Hiểu sai biểu đồ màu: vùng màu đỏ chưa chắc là nguy hiểm nhất – cần đọc giá trị cụ thể. 

Kết quả phụ thuộc nhiều vào chất lượng mô hình: nếu điều kiện biên sai hoặc chia 

lưới không hội tụ, kết quả sẽ sai lệch lớn. Cần thực hiện kiểm tra hội tụ (mesh convergence 

test) và so sánh với dữ liệu thực nghiệm/lý thuyết để đánh giá độ tin cậy.  

Mục tiêu cuối cùng của mô phỏng là hỗ trợ ra quyết định kỹ thuật, vì vậy giai đoạn 

này cần kiến thức nền vững chắc về cơ học vật liệu và khả năng phân tích dữ liệu kỹ thuật. 

Mô phỏng không phải chỉ để “xem màu”, mà là để xác định hành vi thực tế, tiềm ẩn rủi ro 

và đề xuất cải tiến thiết kế. 
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CHƯƠNG 6:PHÂN TÍCH ĐỘ BỀN KHUNG XE FORD RANGER 

VÀ ĐỀ XUẤT CẢI TIẾN 

 

1.Xây dựng mô phỏng kiểm bền khung xe ford Ranger trên phần mềm Hyperworks. 

1.1. Import mô hình vào phần mềm. 

 

Hình 6. 1: Import mô hình vào phần mềm Hypermesh 

Các bước thực hiện 

Trong thanh công cụ, vào File > Import > Geometry (như hình minh họa, biểu 

tượng "Import Geometry" nằm trên thanh công cụ). 

HyperWorks (HyperMesh) hỗ trợ nhiều định dạng file mô hình như: IGES (.igs), 

STEP (.stp), CATIA (.catpart), hoặc các file CAD phổ biến khác từ phần mềm như 

SolidWorks, AutoCAD, hoặc CATIA. 

1.2. Midsurface: Đưa về mặt phẳng trung bình 

Bước thực hiện: Vào Geometry→Midsurface. Tại mục này ta chọn auto 

midsurface, offset+plane+sweeps và sorfed result 
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Hình 6. 2: Thanh công cụ Toobar thực hiện thoa tác chuyển về mặt phẳng trung bình 

 

Hình 6. 3: Sau khi thực hiện midsurface 

Bước này chuyển đổi mô hình hình học của khung xe từ dạng 3D (các khối hoặc bề 

mặt có độ dày) sang dạng 2D (mặt trung bình) để chuẩn bị cho phân tích phần tử hữu hạn 

(FEA) sử dụng phần tử shell (phần tử vỏ). 

Mặt trung bình (midsurface) là bề mặt nằm giữa độ dày của các cấu trúc mỏng (như 

thanh thép của khung xe), giúp đơn giản hóa mô hình mà vẫn đảm bảo độ chính xác trong 

phân tích. 

Khung xe Ford Ranger thường được làm từ thép mỏng 6 mm. Nếu mô phỏng bằng 

phần tử khối (solid elements), sẽ tốn rất nhiều tài nguyên tính toán.  

Mặt trung bình cho phép sử dụng phần tử shell (2D), giảm độ phức tạp, tăng tốc độ 

tính toán, và vẫn mô phỏng chính xác các hiện tượng cơ học như uốn, xoắn, và biến dạng. 

 

1.3. Chia lưới cho mô hình 

Bước thực hiện: Ta dùng phím tắt F12 (Automesh)  
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Tại đây  

 

 

Hình 6. 4: Thanh công cụ toolbar mục chia lưới (phím tắt F12) 

Chia lưới (meshing) là quá trình phân chia mô hình hình học (mặt trung bình của 

khung xe) thành các phần tử hữu hạn (finite elements) để chuẩn bị cho phân tích độ bền 

bằng phương pháp phần tử hữu hạn (FEA) trong HyperWorks.  

Mục tiêu là tạo ra một lưới phần tử (thường là phần tử shell 2D) có kích thước và 

chất lượng phù hợp để mô phỏng chính xác ứng suất, biến dạng, và các hành vi cơ học của 

khung xe dưới các điều kiện tải trọng (như 2G, 1.5G, v.v.). 

Lưới chất lượng cao đảm bảo kết quả phân tích chính xác, đặc biệt tại các khu vực 

phức tạp (mối nối, vùng cong). Kích thước lưới ảnh hưởng trực tiếp đến độ chi tiết và thời 

gian tính toán: lưới mịn hơn tăng độ chính xác nhưng tốn tài nguyên hơn. 

Sau khi tạo mặt trung bình (Midsurface), chia lưới là bước tiếp theo để gán vật liệu, 

áp dụng điều kiện biên, và chạy mô phỏng. 

Chúng ta cần thiết lập những thông số sau: 

− Kích thước phần tử (Element size): 

Kích thước phần tử là độ dài trung bình của mỗi phần tử lưới (quad hoặc tria). Giá trị 

10 mm phù hợp cho mô hình khung xe Ford Ranger (chiều dài 5362 mm), cung cấp sự cân 

bằng giữa độ chính xác và hiệu suất tính toán.  

Lưới với kích thước 10 mm đủ chi tiết để mô phỏng các thanh dọc và ngang của khung 

thang, nhưng nếu có vùng ứng suất cao (như mối nối) 

− Loại lưới (Mesh Type): 

Giá trị (Mixed) :cho phép HyperMesh sử dụng cả phần 

tử tứ giác (quad) và tam giác (tria) để tối ưu hóa lưới dựa trên hình học của mô hình.  

Phần tử quad được ưu tiên vì chất lượng tốt hơn (ít sai số), nhưng tria có thể xuất hiện 

ở các vùng phức tạp (góc, mối nối). 
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− Size and bias, QI optimize, Edge deviation, Surface deviation, Connected features, 

Interactive:  

− Size and bias: Điều chỉnh kích thước và độ dốc của lưới.   

− QI optimize: Tối ưu hóa chất lượng lưới (aspect ratio, warpage).  

− Edge/Surface deviation: Kiểm soát độ lệch của lưới so với cạnh hoặc bề mặt.  

− Connected features: Xử lý các đặc trưng kết nối.  

− Interactive: Cho phép chỉnh sửa lưới bằng tay. 

− Quy trình thực hiện  

− Vào Mesh → Create →2D AutoMesh.  

Đặt Element size = 10.0, Mesh type = mixed, Feature angle = 30.0, Vertex angle = 

30.0, và chọn Anchor nodes. 

 →Nhấn mesh để tạo lưới. 

Nếu lưới không đạt yêu cầu, nhấn reject và điều chỉnh (ví dụ: giảm kích thước hoặc 

thay đổi góc). 

 

Hình 6. 5: lưới mesh sau khi chia 

1.4. Kiểm Tra chất lượng lưới 

Trong HyperMesh, vào Mesh →Check→ Elements→Quality Index (hoặc biểu 

tượng "Check Elements" trên thanh công cụ). 
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Hình 6. 6:Thanh công cụ toolbar thao tác trên Qalityinnex 

 

 

 

Hình 6. 6:Thanh công cụ toolbar thao tác trên Qalityinnex 

 

Hình 6. 7: kiểm tra chất lượng lưới 

Trong HyperMesh,thanh kiểm tra lưới Quality Index (QI) hoặc các công cụ liên 

quan trong menu Check Elements. Đây là nơi hiển thị các tiêu chí chất lượng lưới (như 

Aspect Ratio, Warpage, Skew, v.v.) và cho phép bạn kiểm tra, đánh giá, và sửa lỗi lưới.  

Công cụ này cung cấp giao diện trực quan để bạn xem xét chất lượng lưới, xác định các 

phần tử không đạt tiêu chuẩn, và thực hiện các điều chỉnh cần thiết: 

− Thanh kiểm tra lưới trong HyperMesh thường hiển thị các tiêu chí sau để đánh giá 

chất lượng: 

− Aspect Ratio (Tỷ lệ khía cạnh): Tỷ lệ giữa chiều dài lớn nhất và nhỏ nhất của phần 

tử. Giá trị lý tưởng là gần 1, tối đa thường là 5. 

− Warpage (Độ xoắn): Góc xoắn của phần tử so với mặt phẳng lý tưởng. Tối đa thường 

là 15°-20°. 

− Skew (Độ lệch): Mức độ lệch của góc phần tử so với hình vuông/tam giác lý tưởng. 

Tối đa thường là 45°. 
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− Jacobian (Hằng số Jacobian): Đo độ biến dạng hình học của phần tử. Tối thiểu 

thường là 0.7. 

− Minimum Angle (Góc nhỏ nhất): Góc nhỏ nhất trong phần tử, tối thiểu thường là 

20°-30°. 

− Maximum Angle (Góc lớn nhất): Góc lớn nhất trong phần tử, tối đa thường là 135°. 

− Element Size (Kích thước phần tử): Đảm bảo kích thước phù hợp (ví dụ: 10 mm 

trong trường hợp của bạn) và đồng đều. 

− Sửa lỗi lưới: 

-Tăng độ chi tiết lưới:  

Nếu nhiều phần tử có Aspect Ratio hoặc Skew cao, quay lại 2D AutoMesh và giảm 

kích thước phần tử (ví dụ: từ 10 mm xuống 5 mm) tại các vùng lỗi. 

Điều chỉnh Feature Angle hoặc Vertex Angle (giảm từ 30° xuống 15°) để bắt chi 

tiết hơn. 

− Chỉnh sửa thủ công:  

Sử dụng công cụ Interactive trong 2D AutoMesh để kéo dài hoặc di chuyển các nút, 

cạnh nhằm cải thiện hình dạng phần tử. 

− Sử dụng Refine Mesh để thêm phần tử tại các vùng lỗi. 

− Tối ưu hóa tự động:  

Sử dụng tùy chọn QI Optimize để HyperMesh tự động điều chỉnh lưới, giảm số lượng 

phần tử lỗi. 

 

Hình 6. 8: Thanh công cụ toolbar lệnh QI Optimize 

− Kiểm tra lại:  

Chạy lại Quality Index sau khi sửa để đảm bảo lưới đạt tiêu chuẩn. 
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Hình 6. 9: Lưới đạt chuẩn 

 

1.5. Liên kết mô hình 

Vào Mesh > Create > Connectors (hoặc nhấp biểu tượng "Connectors" trên thanh 

công cụ, như trong hình ảnh). 

Công cụ này được sử dụng để tạo các mối hàn (welds), các kết nối khác trong mô 

hình. 

 

Hình 6. 10: Tạo compoment mối hàn 

Trong bảng điều khiển Connectors, chọn Weld làm loại kết nối. 

− Spot Weld: Cho các mối hàn điểm tại giao điểm (phù hợp với khung xe Ford 

Ranger). 
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− Seam Weld: Cho các đường hàn liên tục. 

 

Hình 6. 11: Mối hàn liên kết giữa các chi tiết với nhau 

 

 

1.6. Tạo thuộc tính. 

1.6.1 Tạo vật liệu  

 Các bước tạo vật liệu: Chuột phải → Creat → Material: 

 

Hình 6. 12: Thao tác tạo vật liệu trên thanh công cụ 

Bước tạo vật liệu trong HyperWorks (HyperMesh) là một phần quan trọng trong 

quy trình phân tích độ bền của khung xe Ford Ranger. Sau khi chia lưới, kiểm tra chất 

lượng lưới, và mô phỏng các mối hàn (bằng RBE2/RBE3), bước này nhằm gán thuộc tính 

vật liệu (material properties) cho các thành phần của khung xe (thanh dọc, thanh ngang, 
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mối hàn) để mô phỏng chính xác hành vi cơ học dưới các điều kiện tải trọng (như 2G, 1.5G 

xoắn, v.v.).,(mô hình khung xe với các mối hàn) 

Khung xe dạng thang (ladder frame) thường được làm từ thép cường độ cao (High-

Strength Low-Alloy steel - HSLA) để đảm bảo độ bền và độ cứng.  Các mối hàn có thể có 

cường độ thấp hơn do ảnh hưởng của nhiệt trong quá trình hàn. 

Bảng thông số vật liệu: 

Bảng 6. 111: Thông số vật vật liệu 

Mật độ và trọng lượng riêng, g/cm3 7,85 

Điểm nóng chảy, ْC 1494-1527 

Nhiệt dung riêng, (J/Kg.K) 473 at 20 ْC 

Modun đàn hồi,GPA 79 

Tỷ lệ Poison 0,3 

Modun Young,GPA 206 

Độ thấm từ, mm2/s 13,9 

 

− Mô-đun Young (E): 210 GPa (210,000 MPa).  

− Hệ số Poisson (NU): 0.3.  

− Tỷ trọng (RHO): 7850 kg/m³.  

− Cường độ chảy (Yield Strength): 245 MPa (tối thiểu theo tiêu chuẩn JIS G3101).  

− Cường độ kéo (Tensile Strength): 400-510 MPa. 

Tiêu chuẩn: Thép SS400 được sản xuất theo tiêu chuẩn JIS G3101 (Japanese Industrial 

Standard), một tiêu chuẩn công nghiệp Nhật Bản dành cho thép cán nóng dùng trong kết 

cấu chung.  

Phân loại: Đây là loại thép carbon thấp (low carbon steel), thuộc nhóm thép kết cấu 

thông dụng, không chứa hợp kim đặc biệt. 

+Gán thông số cho vật liệu 

+Gán các thông số E,G,RHO tương ứng cho vật liệu  
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Hình 6. 13: Gán thông số E,G, RHO 

1.6.2. Tạo bề  dày cho khung xe 

Chuột phải → Creat →Property  

 

Hình 6. 14: Thao tác tạo bề dày cho các chi tiết khung xe 

− Dùng cho lưới 2D (thanh dọc, thanh ngang) của khung xe Ford Ranger.  

− Loại thuộc tính: PSHELL (thường dùng cho phần tử shell trong phân tích tuyến 

tính).  

− Cần định nghĩa độ dày (thickness) và vật liệu (thép SS400). 

Thuộc tính (như PSHELL cho lưới 2D, PRBAR cho mối hàn RBE2/RBE3) đóng 

vai trò trung gian để liên kết vật liệu (thép) với các phần tử của mô hình (lưới 2D, mối 

hàn).  
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Điều này cho phép solver (như OptiStruct) hiểu được các đặc tính cơ học (độ cứng, độ bền) 

của từng phần tử khi tính toán ứng suất, biến dạng. 

Khi gán thuộc tính "Shell_SS400_5mm" (độ dày 5 mm, vật liệu SS400) cho lưới 

2D, solver biết rằng các thanh dọc và thanh ngang của khung xe có độ dày 5 mm và được 

làm từ thép SS400, từ đó tính toán chính xác phản ứng của khung dưới tải trọng (như 2G, 

1.5G xoắn) 

Thuộc tính định nghĩa các thông số hình học (độ dày, đường kính, diện tích mặt 

cắt), phản ánh thiết kế thực tế của khung xe Ford Ranger. Điều này đảm bảo mô phỏng sát 

với thực tế, giúp dự đoán chính xác hành vi của khung xe dưới các điều kiện tải trọng. 

 

Hình 6. 15: Các chi tiết dầm ngang, dọc sau khi gan bề dày 

1.7. Tạo RBE2  

RBE2 (Rigid Body Element 2) là một phần tử thanh cứng (rigid) được sử dụng để 

mô phỏng mối nối cứng (rigid connection) giữa các nút (nodes) trong mô hình. Nó đảm 

bảo rằng các nút được kết nối sẽ di chuyển đồng bộ với nhau, duy trì mối quan hệ tuyến 

tính về chuyển vị (displacement) và quay (rotation). 

1.7.1 Tạo RBE2 cho giá đỡ nhíp 

+Vào tab 1D trên thanh công cụ (hoặc Mesh > Create > 1D Elements).  

+Trong menu Create, chọn Rigids > RBE2 

+Nhấn Update để tạo RBE2. Các đường thẳng (spider-like connections) từ nút trung 

tâm đến các nút phụ thuộc, biểu thị mối nối cứng. 
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Hình 6. 16: Thanh toolbar thực hiện tạo RBE2 

Sử dụng công cụ Nodes để chọn một nút làm nút trung tâm tại điểm tâm của bu-

lông nối nhíp và khung xe. 

 

 

Hình 6. 17: RBE2 tại giá đỡ nhíp 

1.7.2. Tạo RBE 2 thùng xe 

− Dựa vào tạo độ trọng tâm thùng xe để tạo RBE2 

+Vào tab 1D trên thanh công cụ (hoặc Mesh > Create > 1D Elements).  

+Trong menu Create, chọn Rigids > RBE2 

− Nút trung tâm (Independent Node): Chọn nút tại trung tâm của mỗi điểm gắn (toạ 

độ trọng tâm) 

− Nút phụ thuộc (Dependent Nodes): Chọn các nút trên bề mặt thùng xe và khung 

gầm xung quanh điểm gắn. 
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Hình 6. 18: RBE2 tạo toạ độ trọng tâm khung xe 

 

1.7.3. Tạo RBE2 thùng cabin 

Cabin của Ford Ranger được gắn với khung gầm qua các điểm cố định ở đáy cabin 

(các vị trí bu-lông tại hai bên và trước/sau). Mỗi điểm gắn sẽ cần một RBE2 để mô phỏng 

mối nối cứng. 

 

Hình 6. 19:Các vị trí đáy khung cabin 

Trong cửa sổ RBE2, nhấp vào Create.  

Sử dụng công cụ Nodes để chọn hoặc tạo một nút làm nút trung tâm tại điểm gắn 

(tâm bu-lông nối cabin với khung).  
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Hình 6. 20: RBE2 tạo toạ độ trọng tâm thùng xe 

1.7.4. Tạo RBE2 động cơ 

Vào tab 1D trên thanh công cụ hoặc Mesh > Create > 1D Elements.  

Chọn Rigids > RBE2. 

Sử dụng công cụ Nodes để chọn hoặc tạo một nút làm nút trung tâm tại điểm gắn 

tâm của bu-lông nối giá đỡ động cơ với khung).  

 

Hình 6. 21: vị trí gắn bulong động cơ 

Hình: vị trí gắn bulong động cơ 

Chuyển sang phần Dependent Nodes trong cửa sổ RBE2.  

Chọn các nút trên bề mặt động cơ (hoặc khối động cơ) và khung gầm xung quanh 

điểm gắn (ví dụ: các nút trong vòng tròn 5-10mm quanh bu-lông). Có thể chọn thủ công 

hoặc chọn một vùng bề mặt (surface) để HyperMesh tự động xác định các nút. 
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Hình: RBE2 động cơ 

1.7.5. Tạo thanh Beam. 

 Thanh beam đơn giản hóa mô hình, giảm thời gian tính toán so với lưới 2D/3D, 

nhưng vẫn mô phỏng được khả năng chịu tải (uốn, xoắn).  

Mesh > Create > 1D > HyperBeams (hoặc nhấp biểu tượng "1D Elements" trên 

thanh công cụ). 

 

Hình 6. 22: Thanh công cụ toolbar tạo thanh beam 

Hình: Thanh công cụ toolbar tạo thanh beam. 

 

Chọn nút thủ công tại 2 đầu thanh Beam: 
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Hình 6. 23: Thanh Beam tại 2 đàu giá đỡ nhíp 

 

Hình: Thanh Beam tại vị trí giá đỡ nhíp 
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Hình 6. 24: Thanh Beam tại vị trí giảm chấn cầu trước  

Hình: Thanh Beam tại vị trí giảm chấn cầu trước 

1.8. Giả lập khối lượng 

Thêm khối lượng tập trung để đại diện cho trọng lượng xe, và sau đó áp dụng gia tốc 

Tạo compoment   

 Vào Mesh > Create > 0D > Masses (hoặc nhấp biểu tượng "0D Elements" trên thanh 

công cụ Mesh).  

 

 

Hình 6. 25: Công cụ này cho phép tạo phần tử lưới trung lập ( concentrated mass) 

 

Hình: Công cụ này cho phép tạo phần tử khối lượng tập trung (concentrated mass). 

-Đặt khối lượng tại vị trí toạ độ trọng tâm, thùng xe, cabin, động cơ 
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Hình 6. 26 :Đặt khối lượng tại các vị trí 

Hình: Đặt khối lượng tại các vị trí 

 

1.9. Đặt điều kiện biên. 

1.9.1. Tạo SPC 

SPC là ràng buộc đơn điểm trong phân tích phần tử hữu hạn (FEA), được sử dụng 

để cố định các độ tự do (displacements) tại các nút hoặc điểm cụ thể trên mô hình. Trong 

trường hợp này, việc tạo SPC tại các vị trí tâm bánh xe nhằm mô phỏng việc cố định bánh 

xe với mặt đường hoặc trục, đảm bảo khung xe không di chuyển tự do trong các điều kiện 

biên như sập hố, quay vòng, hoặc phanh gấp. 

Các bước tạo SPC: 

− Trong panel Load Collectors, nhấp chuột phải và chọn Create để tạo một bộ sưu tập 

tải mới.  

− Đặt tên SPC và chọn như trong hình ảnh. 

Formatted: Keep with next

Formatted: Caption, Left, Line spacing:  single



Tính toán kiểm nghiệm khung xe ô tô Ford Ranger 

 

 

Sinh viên thực hiện: Nguyễn Hoàng Ý 55 Hướng dẫn: TS. Phan Mình Đức 

Formatted: Font: (Default) Times New Roman, 12 pt, Italic

Formatted: Centered

Formatted: Font: (Default) Times New Roman

Formatted: Font: (Default) Times New Roman

 

Hình 6. 27: Tạo SPC trong Load Collectors 

Hình: Tạo SPC trong Load Collectors 

− Đảm bảo Card Image được đặt là None hoặc SPC (tùy tùy chọn solver) 

− Vào menu BCs > Create > Constraints.  

− Chọn Load Collector là "SPC_Wheels" vừa tạo.  

− Chọn các nút tại tâm bánh xe bằng cách sử dụng công cụ Nodes Selector. 

 

−  

− Hình 6. 28: Ngàm SPC tại tâm bánh xe 

−  
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Hình 6. 28: Ngàm SPC tại tâm bánh xe 
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Hình: Ngàm SPC tại tâm bánh xe 

1.9.2. Trường hợp bánh xe sập hố 

 

Hình 6. 29: Điều kiện biên gán cho trường hợp bánh xe sập hố 

 Với trục Y là thẳng đứng, giá trị N2 = -2.0 mô phỏng lực va chạm thẳng đứng (hướng 

xuống dưới) với gia tốc 2.0G. Vì khi bánh xe rơi vào ổ gà, lực tác động thẳng đứng có thể 

đạt 1-3G tùy độ sâu và tốc độ.  

N1 = 0.0: Không có lực dọc xe, phù hợp vì sập hố chủ yếu tạo lực thẳng đứng.  

 N3 = 0.0: Không có lực ngang, hợp lý nếu va chạm không lệch tâm.  

Lực -2.0G theo trục Y (thẳng đứng) mô phỏng tác động mạnh khi bánh xe tiếp đất sau khi 

sập hố, gây nén lớn lên khung xe, đặc biệt tại giá đỡ giảm chấn. 
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1.9.3. Trường hợp quay vòng 

 

Hình 6. 30:Điều kiện biên đối với trường hợp bánh xe quay vòng 

 

1.9.3. Trường hợp quay vòng 

 

Hình 6. 30:Điều kiện biên đối với trường hợp bánh xe quay vòng 

 

Hình: Điều kiện biên đối với trường hợp quay vòng 
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Trong trường hợp quay vòng, khung xe chịu tác động từ lực ly tâm (lateral force) 

do chuyển động cong và trọng lực. Điều kiện biên được thiết lập trong HyperMesh mô 

phỏng các lực này như sau: 

   +N2: -1.0 (trục Y, lực hướng âm, mô phỏng lực ly tâm).  

+N3: -0.5 (trục Z, lực hướng âm, mô phỏng trọng lực). 

+N1 = 0.0: Không có lực theo trục X (hướng dọc xe), vì quay vòng chủ yếu tạo 

lực ngang. 

1.9.4. Trường hợp phanh gấp 

 

Hình 6. 31Điều kiện biên đối với trường hợp xe phanh gấp 

Hình: Điều kiện biên trường hợp xe phanh gấp 

Trong trường hợp phanh gấp, khung xe chịu tác động chính từ lực quán tính do 

giảm tốc đột ngột. Điều kiện biên được thiết lập trong HyperMesh mô phỏng tải trọng 

này như sau: 

+N1 = -0.8: Trục X có giá trị âm (-0.8), mô phỏng lực quán tính hướng ngược chiều 

trục X dương. Điều này phản ánh gia tốc giảm tốc 0.8g, tình huống phanh gấp 

(thường 0.6-1G tùy vào ma sát lốp và mặt đường).  

+N2 = -1.0: Trục Y có giá trị âm (-1.0), mô phỏng lực ngang hoặc sai lệch thiết lập. 

Trong phanh gấp, lực ngang không phải là yếu tố chính, nên giá trị này có thể là lỗi 

hoặc do ảnh hưởng từ các tải khác (cần kiểm tra).  
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+N3 = 0.0: Trục Z (hướng thẳng đứng) không có lực, cho thấy trọng lực không được 

áp dụng trong tải này, có thể do các tải khác bổ sung. 

2.Đánh giá kết quả và đề xuất phương án cải tiến kết cấu khung xe 

2.1.Trường hợp xe sập hố 

 

Hình 6. 32: Kết quả trường hợp bánh xe sập hố 

Hình: Kết quả trường hợp sập hố 

Đại lượng: Độ dịch chuyển tổng thể (Displacement Magnitude) 

Giá trị lớn nhất: 7.51 mm tại node 134560 

Trong trường hợp mô phỏng sập hố, khung xe được đặt vào tình huống phải chịu tải 

trọng lớn và bất ngờ từ phía dưới do bánh xe bị lọt vào ổ gà hoặc hố sâu. Kết quả phân tích 

thể hiện rõ hai yếu tố chính: độ biến dạng tổng thể và phân bố ứng suất Von Mises trên 

khung. 

Về độ biến dạng, kết quả bên trái cho thấy giá trị dịch chuyển lớn nhất là 7.51 mm 

tại node 134560. Biến dạng này tập trung chủ yếu ở vùng giữa khung xe, gần các vị trí liên 

kết với hệ thống treo. Màu đỏ trên biểu đồ cho thấy các khu vực này là nơi chịu ảnh hưởng 

mạnh nhất của lực tác động từ dưới lên. Mặc dù giá trị này chưa vượt ngưỡng gây nguy 

hiểm nghiêm trọng, nhưng vẫn có thể dẫn đến biến dạng dẻo cục bộ nếu lặp lại nhiều lần 

hoặc trong điều kiện đường xấu kéo dài. 

Về mặt ứng suất, biểu đồ bên phải cho thấy ứng suất Von Mises cực đại đạt tới 

471.85 MPa tại node 117861. Đây là giá trị vượt xa giới hạn chảy của vật liệu SS400 (~245 

MPa), đồng nghĩa với nguy cơ rất cao xảy ra biến dạng dẻo hoặc phá hủy tại vùng chịu tải. 
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Vị trí ứng suất cực đại nằm ở khu vực cong phía trước khung, thường là nơi tập trung ứng 

suất do hình học và tác động tải trọng phức tạp. Nếu không được gia cường, đây sẽ là điểm 

yếu dễ bị nứt hoặc gãy trong thực tế. 

Từ các kết quả phân tích trên, có thể kết luận rằng trong kịch bản sập hố, khung xe 

hiện tại chưa đủ khả năng chịu tải an toàn. Để đảm bảo độ bền kết cấu, cần xem xét tăng 

độ dày tấm tại các vùng nguy hiểm, bổ sung gân tăng cứng, thay đổi thiết kế mặt cắt khung 

hoặc lựa chọn vật liệu có giới hạn chảy cao hơn. Ngoài ra, việc kiểm tra thêm với mô hình 

phi tuyến có thể giúp đánh giá rõ hơn nguy cơ biến dạng dẻo trong điều kiện tải trọng thực 

tế. 

2.2. trường hợp quay vòng 

 

Hình 6. 33: Trường hợp xe quay vòng 

Trong trường hợp mô phỏng quay vòng, khung xe phải chịu tải trọng bên lớn do lực 

ly tâm tác động khi xe quay vòng ở tốc độ cao. Kết quả mô phỏng cho thấy mức độ biến 

dạng và ứng suất khác biệt so với các tình huống tải trọng dọc như sập hố. 

Về biến dạng, hình ảnh bên trái cho thấy độ dịch chuyển lớn nhất là 6.26 mm tại node 

135021. Biến dạng phân bố chủ yếu ở vùng giữa và hai bên sườn của khung xe – nơi lực 

ngang tập trung tác động khi xe chuyển hướng. Mặc dù nhỏ hơn so với trường hợp sập hố 

(7.51 mm), nhưng đây vẫn là một con số đáng chú ý, đặc biệt nếu xe quay gấp ở tốc độ cao 

hoặc trên địa hình không bằng phẳng. 

Về ứng suất Von Mises, kết quả bên phải thể hiện giá trị cực đại là 157.55 MPa tại 

node 73674. Mức ứng suất này tuy chưa vượt qua giới hạn chảy của vật liệu SS400 (~245 
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MPa), nhưng đã ở mức tương đối cao, cần được theo dõi cẩn thận. Ứng suất tập trung tại 

các vùng nối giữa khung chính và khung phụ – khu vực thường xuyên chịu uốn xoắn khi 

xe chuyển hướng đột ngột. 

Tổng thể, khung xe vẫn trong giới hạn làm việc an toàn nhưng cần tối ưu thêm để 

tăng khả năng chống xoắn và đảm bảo độ bền lâu dài khi xe vận hành ở tốc độ cao hoặc tải 

trọng lớn. 

2.3.Trường hợp phanh gấp 

 

Hình 6. 34: Trường hợp xe phanh gấp 

 

Trong trường hợp mô phỏng phanh gấp, khung xe phải chịu tải trọng dọc đột ngột, 

chủ yếu tập trung tại các điểm kết nối giữa cầu xe và khung chính. Dữ liệu mô phỏng cho 

thấy biến dạng và ứng suất phát sinh tương đối nhỏ so với các tình huống như sập hố hay 

quay vòng. 

Cụ thể, hình ảnh bên trái mô tả độ dịch chuyển tối đa là 0.69 mm tại node 81135. 

Biến dạng này xảy ra chủ yếu ở vùng giữa của khung – nơi truyền lực hãm từ hệ thống 

phanh qua các liên kết. So với các tình huống khác, giá trị này rất thấp, chứng tỏ khung có 

độ cứng vững cao và phản ứng tốt trước lực phanh. 

Hình ảnh bên phải thể hiện ứng suất Von Mises cực đại là 52.89 MPa tại node 

122119. Mặc dù đây là mức thấp so với giới hạn chảy của thép SS400 (~245 MPa), nhưng 
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vẫn có ý nghĩa trong việc đánh giá vùng tập trung ứng suất. Ứng suất chủ yếu xuất hiện tại 

các điểm nối và thanh ngang – những nơi có thay đổi hình học hoặc tập trung tải trọng. 

Từ kết quả trên có thể rút ra kết luận rằng khung xe đáp ứng tốt với tải trọng do 

phanh gấp gây ra, với độ dịch chuyển nhỏ và ứng suất phân bố đều. Tuy nhiên, cần lưu ý 

kiểm tra bền mỏi lâu dài tại các vùng có ứng suất tập trung, vì việc phanh gấp thường xuyên 

có thể gây tích lũy ứng suất theo thời gian, ảnh hưởng đến tuổi thọ cấu trúc. Đây là một 

yếu tố quan trọng trong thiết kế và kiểm nghiệm thực tế khung xe. 

2.4. Đề xuất phương án cải tiến 

 

Hình 6. 35: Ứng suất tại giá đỡ giảm chấn trường hợp banh xe sập hố 

 Hình Ứng suất lớn nhất tại giá đỡ giảm chấn trường hợp sập hố 

Khu vực giá đỡ giảm chấn chịu ứng suất cao (471.85 MPa), vượt giới hạn vật liệu, cần cải 

thiện. Tăng bề dày và di chuyển vị trí ra khỏi vùng cong là giải pháp hợp lý, kết hợp gia cố 

và kiểm tra vật liệu. Mô phỏng lại trong HyperMesh để đảm bảo ứng suất giảm xuống mức 

an toàn. 

2.4.1. Nguyên nhân gây ra ứng suất cao tại giá đỡ giảm chấn 

− Hình học phức tạp: Vùng cong tại giá đỡ giảm chấn tạo ra hiệu ứng tập trung ứng 

suất, nơi các lực được truyền từ giảm chấn xuống khung xe không được phân tán 

đều.  

− Tải trọng lớn: Các điều kiện biên như phanh gấp (-0.8G theo trục X) và quay vòng 

(-0.5G theo trục Y) gây ra chuyển dịch trọng lượng (weight transfer), tăng tải trọng 

lên khu vực này, đặc biệt khi trục trước hoặc bánh xe phía ngoài chịu lực lớn.  
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− Độ dày vật liệu: Độ dày tại khu vực này mỏng (2,5mm), khả năng chịu tải giảm, 

dẫn đến ứng suất vượt giới hạn.  

2.4.2. Đề xuất phương án cải tiến. 

2.4.2.1. Tăng độ dày cục bộ 

Tăng bề dày cục bộ tại khu vực giá đỡ giảm chấn (nơi có ứng suất tối đa 471.85 

MPa) nhằm giảm ứng suất bằng cách tăng diện tích mặt cắt chịu tải. Điều này giúp phân 

tán lực tốt hơn, giảm nguy cơ hỏng hoặc biến dạng dẻo tại vùng ứng suất cao. 

Tăng độ dày vật liệu tại khu vực ứng suất lớn (từ 2,5 mm lên 4,5 mm) để tăng khả 

năng chịu tải, giảm ứng suất. 

 

 

Hình 6. 36: Đề xuất cải tiến bằng cach răng bề dày tại vị trí ứng suất lớn 

 

Hình: đề xuất cải tiến bằng cách tăng bề dày tại vị trí ứng suất lớn 
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2.4.2.2. Dịch chuyển vị trí lỗ giảm chấn thoát khỏi vùng cong 

 

Hình 6. 37:Vị trí lỗ được dịch chuyển ra khỏi vùng cong 

Hình: Vị trí lỗ được dịch chuyển ra khỏi vùng cong 

Vùng cong là nơi dễ xảy ra hiệu ứng tập trung ứng suất do thay đổi hình học đột 

ngột. Hệ số tập trung ứng suất (Kt) tại vùng cong có thể từ 2-3, làm tăng ứng suất cục bộ 

(ví dụ: từ 200 MPa lên 471.85 MPa). 

Di chuyển lỗ (giá đỡ giảm chấn) đến vùng phẳng hơn sẽ giảm Kt xuống gần 1, giúp 

ứng suất giảm đáng kể, có thể xuống dưới 245 MPa, nằm trong ngưỡng an toàn. 

Giảm ứng suất cục bộ giúp khung xe tránh biến dạng dẻo hoặc nứt tại vùng giá đỡ, 

đặc biệt dưới tải trọng lặp lại (phanh gấp, quay vòng, sập hố). Điều này cũng tăng khả năng 

chống mỏi (fatigue resistance), kéo dài tuổi thọ khung xe. 
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Hình 6. 38: Gia đỡ giảm chấn sau khi được cải tiến 

 

Hình: Giá đỡ giảm chấn sau khi được cải tiến 

Ứng suất tối đa giảm từ 471.85 MPa xuống 226 MPa, tức giảm khoảng 52%. Giá trị 

226 MPa nằm trong ngưỡng an toàn của thép (ứng suất chảy 245MPa) đảm bảo không có 

biến dạng dẻo hoặc hỏng. 

Điều này cho thấy các phương án cải tiến (tăng độ dày cục bộ, di chuyển lỗ ra khỏi 

vùng cong, thêm gia cố) đã hiệu quả trong việc giảm tập trung ứng suất. 

 2.4.2.2. Rút bớt vật liệu tại vị trí dư bền. 

Các vị trí dầm ngang 1,2,3,4, đang là vị trí dư bền với ứng suất Von Mises tối đa 

đạt 4.024E+01 MPa (40.24 MPa), và tối thiểu là 1.607E+00 MPa (1.607 MPa). Các khu 

vực tại 4 thanh dầm ngang (cross members) của khung xe, đặc biệt là vùng giữa khung, có 

ứng suất rất thấp (màu xanh dương, khoảng 1.607-8.943 MPa), cho thấy các thanh này 

không chịu tải trọng lớn trong điều kiện phanh gấp. 
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Hình 6. 39: 4 thanh dầm ngang trường hợp phanh gấp chưa cái tiến 

 

Hình 6. 40: 4 thanh dầm gnang ở trường hợp sập hố chưa cải tiến 

 

 

 

 

Hình 6. 39: 4 thanh dầm ngang trường hợp phanh gấp chưa cái tiến 

Hình: 4 thanh dầm ngang ứng suất thấp phanh gấp chưa cải tiến 
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Hình 6. 40: 4 thanh dầm gnang ở trường hợp sập hố chưa cải tiến 

Hình: 4 thanh dầm ngang ở trường hợp sập hố chưa cải tiến 

 

Hình 6. 41:4 thanh dầm ngang ở trường hợp quay vòng chưa cải tiến 

Hình: 4 thanh dầm ngang ở trường hợp quay vòng chưa cải tiến 

Rút bớt vật liệu tại các thanh dầm ngang là phương án Lightweighting Design (tối 

ưu hóa trọng lượng), nhằm giảm trọng lượng khung xe, tiết kiệm chi phí, và cải thiện hiệu 

suất, trong khi vẫn đảm bảo độ bền và an toàn. 

Giảm độ dày của 4 thanh dầm ngang (từ 6,5mm xuống 4 mm) tại các vùng có ứng 

suất thấp.  
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Hình 6. 42: 4 thanh dầm ngang trương hợp sập hố đã cải tiến 

 

Hình 6. 43: 4 thanh dầm ngang trường hợp phanh gấp đã cải tiến 

 

 

 

Sử dụng HyperMesh để xác định các vùng cụ thể (màu xanh dương) và điều chỉnh 

độ dày hoặc loại bỏ vật liệu thừa (có thể khoét lỗ hoặc giảm tiết diện). 
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Hình 6. 42: 4 thanh dầm ngang trương hợp sập hố đã cải tiến 

Hình: 4 thanh dầm ngang trường hợp sập hố đã cải tiến 

 

Hình 6. 43: 4 thanh dầm ngang trường hợp quay vòng đã cải tiến 

Hình: 4 thanh dầmn ngang trường hợp quay vòng đã cải tiến 

 

Hình 6. 44: 4 thanh dầm ngang trường hợp phanh gấp đã cải tiến 

Hình: 4 thanh dầm ngang trường hợp phanh gấp đã cải tiến 
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Giảm độ dày từ 6,5 mm xuống 4 mm (giảm khoảng 38,5% độ dày) tại 4 thanh dầm 

ngang sẽ giảm đáng kể trọng lượng. 

− Sập hố (225.99 MPa): Ứng suất cao nhất tập trung tại các điểm gần bánh xe (Grid 

125685), không phải tại thanh dầm ngang. Các thanh dầm ngang có ứng suất thấp 

hơn (dưới 50 MPa), cho thấy chúng không phải là khu vực chịu lực chính trong 

trường hợp này.  

− Quay vòng (159.72 MPa): Ứng suất tối đa tại Grid 33203 (gần giá đỡ), trong khi 

các thanh dầm ngang vẫn ở mức thấp (dưới 50-100 MPa), phù hợp với tải ngang.  

− Phanh gấp (40.24 MPa): Ứng suất rất thấp tại các thanh dầm ngang (1.607-8.943 

MPa), chứng tỏ giảm độ dày không ảnh hưởng đáng kể đến khả năng chịu lực trong 

trường hợp này.  

Việc rút bớt vật liệu tại 4 thanh dầm ngang từ 6,5 mm xuống 4 mm là thành công, với 

ứng suất sau cải tiến vẫn an toàn (dưới 50-100 MPa tại thanh dầm, 225.99 MPa tại điểm 

yếu khác). Phương án Lightweighting Design đạt hiệu quả giảm trọng lượng mà không ảnh 

hưởng lớn đến độ bền. 

3. Đánh giá kết quả phương án cải tiến khung xe 

Kết quả mô phỏng trong HyperMesh cho trường hợp sập hốsau khi cải tiến giá đỡ 

giảm chấn cho thấy ứng suất tối đa giảm từ 471.85 MPa xuống 226 MPa, giảm 52%. 

Trước cải tiến, ứng suất tại vùng cong của giá đỡ vượt giới hạn vật liệu (250-400 MPa), 

gây nguy cơ biến dạng dẻo. Sau khi tăng độ dày cục bộ (từ 2,5 mm lên 4,5 mm) và dịch 

chuyển lỗ ra vùng phẳng, ứng suất phân bố đều hơn, dao động từ 50.22 MPa (màu xanh 

lam) đến 226 MPa (màu đỏ). Giá trị 226 MPa nằm trong ngưỡng an toàn, tăng độ bền và 

khả năng chống mỏi.  

 

Hình 6. 444445: Khung xe trường hợp sập hố sau khi được cải tiến 
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Hình: Khung xe trường hợp sập hố sau khi được cải tiến 

Rút bớt vật liệu với kết quả mô phỏng sau khi giảm độ dày 4 thanh dầm ngang từ 

6,5 mm xuống 4 mm cho thấy hiệu quả rõ rệt. Trong trường hợp phanh gấp (Subcase 3), 

ứng suất tại các thanh dầm rất thấp (1.607-8.943 MPa), ngay cả khi giảm độ dày 38,5%. 

Với quay vòng (159.72 MPa) và sập hố (225.99 MPa), ứng suất tại các thanh dầm vẫn dưới 

50-100 MPa, đảm bảo an toàn. Phương án Lightweighting Design này giảm trọng lượng 

khung xe khoảng 1-1.5 kg, tiết kiệm chi phí mà không ảnh hưởng độ bền. Tuy nhiên, cần 

kiểm tra biến dạng tổng thể và phân tích mỏi để tránh rủi ro dài hạn. 

Các phương án cải tiến đạt hiệu quả: giá đỡ giảm chấn an toàn hơn với ứng suất 

giảm xuống 226 MPa, và 4 thanh dầm ngang giảm vật liệu thành công mà vẫn bền vững. 

Cần kiểm tra thêm biến dạng, mỏi, và các trường hợp tải khác để tối ưu hóa thiết kế. 

4. Sự thay đổi khối lượng sau cải tiến khung xe 

Khối lượng của dầm ngang, giá đỡ giảm chấn trước cải tiến: 

Bảng 6.2: khối lượng chi tiết trước khi cải tiến 

Chi tiết cải tiến Khối lượng (Kg) 

Dầm ngang 1 8,63 

Dầm ngang 2 7,97 

Dầm ngang 3 11,83 

Dầm ngang 4 16,87 

Giá đỡ giảm chấn 14,18x2 

 

 

Hình 6.46: Thanh dầm ngang 1 
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Hình 6.47: Thanh dầm ngang 2 chưa cải tiến 

 

Hình 6.48: Thanh dầm ngang 3 chưa cải tiến 

 

Hình6.49: Thanh dầm ngang 4 chưa cải tiến 
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Khối lượng dầm ngang, giá đỡ giảm chấn sau cải tiến 

Bảng 6.3: Khối lượng các chi tiết sau cải tiến 

Chi tiết cải tiến Khối lượng (Kg) 

Dầm ngang 1 6,31 

Dầm ngang 2 4,9 

Dầm ngang 3 7,27 

Dầm ngang 4 10,38 

Giá đỡ giảm chấn 14,64 x2 

 

 

 

Hình 6.50: thanh dầm ngang 1 đã cải tiến 

 

Hình 6.51: Thanh dầm ngang 2 đã cải tiến 
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Hình 6.52: Thanh dầm ngang 3 đã được cải tiến 

 

Hình 6.53: Giá đỡ giảm chấn 

Phương án rút vật liệu tại 4 thanh dầm ngang và giá đỡ giảm chấn đã thành công, 

với ứng suất tại các thanh này luôn dưới 10-50 MPa trong mọi trường hợp tải, khẳng định 

khả năng tối ưu hóa vật liệu mà vẫn đảm bảo an toàn. Việc tăng độ dày cục bộ tại giá đỡ 

giảm chấn và di chuyển lỗ ra khỏi vùng cong không chỉ giảm ứng suất mà còn cải thiện độ 

bền tổng thể, phù hợp với mục tiêu đề cương về cải tiến kết cấu khung xe Ford Ranger. 

Kết quả tính khối lượng sau cải tiến (dùng công cụ Mass Calc trong HyperMesh) cho thấy 

giảm 15,5 Kg đáng kể chi phí vật liệu, góp phần nâng cao hiệu suất và tiết kiệm nhiên liệu. 
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CHƯƠNG 7: KẾT LUẬN VÀ ĐỊNH HƯỚNG PHÁT TRIỂN 

 

1.Kết luận về kết quả nghiên cứu 

Đồ án tốt nghiệp thực hiện phân tích và cải tiến thiết kế khung xe Ford Ranger bằng 

phương pháp mô phỏng trên phần mềm Hyperworks, tuân thủ theo đề cương đã đề ra, bao 

gồm các nội dung chính: tổng quan về thiết kế khung xe, phân tích kết cấu, tối ưu hóa vật 

liệu, và đề xuất giải pháp phát triển. Nghiên cứu tập trung vào việc mô phỏng và cải tiến 

khung xe dưới ba trường hợp tải trọng chính là sập hố, quay vòng, và phanh gấp, áp dụng 

các giải pháp cụ thể như rút bớt vật liệu tại 4 thanh dầm ngang, di chuyển lỗ lắp giảm chấn 

ra khỏi vùng cong, và tăng bề dày cục bộ tại khu vực giá đỡ giảm chấn. Qua quá trình thực 

hiện, đồ án đã đạt được những kết quả quan trọng, đồng thời xác định các hạn chế và định 

hướng cải tiến để hoàn thiện thiết kế khung xe, đáp ứng mục tiêu tối ưu hóa kết cấu và hiệu 

suất. 

Kết quả mô phỏng trước và sau cải tiến cho thấy sự cải thiện rõ rệt về độ bền và 

hiệu quả trọng lượng của khung xe. Đối với trường hợp sập hố, ứng suất tối đa giảm từ 

471.85 MPa xuống 226 MPa tại giá đỡ giảm chấn, nhờ việc tăng độ dày cục bộ và di chuyển 

lỗ ra vùng phẳng, giảm hiệu ứng tập trung ứng suất. Điều này đảm bảo ứng suất nằm trong 

ngưỡng an toàn (dưới 250-400 MPa), tăng khả năng chịu tải và chống mỏi.. Biến dạng tối 

đa (8.06 mm) trong trường hợp này cũng cho thấy khung vẫn duy trì độ cứng tốt, phù hợp 

với yêu cầu thiết kế. 

Trong trường hợp quay vòng, ứng suất tối đa giảm còn 159.72 MPa tại khu vực giá 

đỡ, trong khi biến dạng tối đa là 6.67 mm. Việc di chuyển lỗ lắp giảm chấn đã giúp phân 

tán lực tốt hơn, tránh tập trung ứng suất tại vùng cong, đồng thời giữ ứng suất tại các thanh 

dầm ngang ở mức thấp (dưới 50-100 MPa). Trường hợp phanh gấp đạt ứng suất tối đa chỉ 

40.24 MPa, với biến dạng tối đa rất nhỏ (không đáng kể), chứng minh hiệu quả của việc 

rút bớt vật liệu tại 4 thanh dầm ngang từ 6,5 mm xuống 4 mm, giảm trọng lượng khung xe 

mà không ảnh hưởng đến độ bền. 

Phương án Lightweighting Design tại 4 thanh dầm ngang đã thành công, với ứng 

suất tại các thanh này luôn dưới 10-50 MPa trong mọi trường hợp tải, khẳng định khả năng 

tối ưu hóa vật liệu mà vẫn đảm bảo an toàn. Việc tăng độ dày cục bộ tại giá đỡ giảm chấn 

và di chuyển lỗ ra khỏi vùng cong không chỉ giảm ứng suất mà còn cải thiện độ bền tổng 

thể, phù hợp với mục tiêu đề cương về cải tiến kết cấu khung xe Ford Ranger. Kết quả tính 

khối lượng sau cải tiến (dùng công cụ Mass Calc trong HyperMesh) cho thấy giảm đáng 

kể chi phí vật liệu, góp phần nâng cao hiệu suất và tiết kiệm nhiên liệu. 
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Tuy nhiên, nghiên cứu vẫn tồn tại một số hạn chế. Lỗi hiển thị ứng suất tối thiểu 

trong mô phỏng sập hố cần được kiểm tra lại lưới hoặc solver. Biến dạng tối đa (8.06 mm) 

trong sập hố và quay vòng (6.67 mm) cần so sánh với ngưỡng cho phép (thường 0.1-0.5% 

chiều dài khung) để đảm bảo độ cứng tổng thể. Ngoài ra, phân tích mỏi (fatigue analysis) 

với tải trọng lặp lại chưa được thực hiện, là yếu tố quan trọng để đánh giá độ bền dài hạn. 

Hiệu ứng nhiệt hoặc va chạm mạnh ngoài mô phỏng cũng cần xem xét để đảm bảo tính 

thực tiễn. 

Dựa trên đề cương, nghiên cứu đã hoàn thành các mục tiêu: tổng quan thiết kế khung 

xe, phân tích kết cấu qua HyperWorks, và đề xuất phương án cải tiến. Hướng phát triển 

tiếp theo là thực hiện phân tích mỏi, thử nghiệm thực tế khung xe với các điều kiện tải 

tương tự, và tích hợp các giải pháp gia cố (như gusset plates) tại các điểm ứng suất cao 

(225.99 MPa). 

 Kết luận, đồ án không chỉ đạt được mục tiêu tối ưu hóa thiết kế mà còn mở ra hướng 

nghiên cứu sâu hơn, đóng góp vào việc nâng cao chất lượng khung xe Ford Ranger trong 

tương lai. 

 

 

Hình 7. 1: Khung xe với trường hợp quay vòng đã được cải tiến 

Hình: khung xe với trường hợp quay vòng đã được cải tiến 

Trong trường hợp quay vòng, kết quả mô phỏng cho thấy ứng suất tối đa tại khu 

vực giá đỡ giảm chấn là 159.72 MPa, với biến dạng tối đa là 6.67 mm, phản ánh hiệu quả 

của việc di chuyển lỗ lắp ra vùng phẳng và phân tán lực tốt hơn. Các thanh dầm ngang, sau 

khi rút bớt vật liệu từ 6,5 mm xuống 4 mm, duy trì ứng suất ở mức thấp (dưới 50-100 MPa), 

chứng minh phương án Lightweighting Design thành công mà không ảnh hưởng đến độ 

bền. Ứng suất này nằm dưới ngưỡng an toàn, phù hợp với tải trọng ngang (N3 = -1.0G). 
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Tuy nhiên, cần kiểm tra biến dạng tổng thể để đảm bảo độ cứng không bị suy giảm đáng 

kể. Hướng phát triển tiếp theo là thực hiện phân tích mỏi và thử nghiệm thực tế để xác 

nhận khả năng chịu tải lặp lại, đồng thời xem xét gia cố tại các điểm ứng suất cao nếu cần 

thiết. 

 

 

Hình 7. 2: Khung xe với trường hợp sập hố đã được cải tiến 

Hình: Khung xe với trường hợp sập hố đã được cải tiến 

Đối với trường hợp sập hố, nghiên cứu đã đạt được những tiến bộ đáng kể trong 

việc cải tiến khung xe Ford Ranger thông qua mô phỏng trên HyperMesh. Ứng suất tối đa 

tại giá đỡ giảm chấn giảm từ 471.85 MPa xuống 226 MPa sau khi áp dụng các biện pháp 

tăng bề dày cục bộ (từ 2 mm lên 3 mm) và di chuyển lỗ lắp giảm chấn ra khỏi vùng cong. 

Giá trị này nằm trong ngưỡng an toàn (dưới 250-400 MPa), đảm bảo khung xe không bị 

biến dạng dẻo hoặc hỏng khi chịu tải trọng thẳng đứng cao (N2 = -2.0g). Biến dạng tối đa 

đạt 8.06 mm, cho thấy độ cứng vẫn được duy trì tốt, phù hợp với thiết kế thực tế. Tuy 

nhiên, lỗi hiển thị ứng suất tối thiểu (1.691E+13 MPa) cần được khắc phục bằng cách kiểm 

tra lại lưới hoặc solver để đảm bảo độ tin cậy. Hướng cải tiến thêm bao gồm phân tích mỏi 

để đánh giá độ bền dài hạn và gia cố thêm tại các điểm ứng suất cao nếu cần. 
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Hình 7. 3:Khung xe với trường hợp phanh gấp đã được cải tiến 

 

Hình: Khung xe với trường hợp phanh gấp đã được cải tiến 

Đối với trường hợp phanh gấp, kết quả mô phỏng cho thấy ứng suất tối đa chỉ đạt 

40.24 MPa, với biến dạng tối đa rất nhỏ, phản ánh hiệu quả của việc rút bớt vật liệu tại 4 

thanh dầm ngang. Việc giảm độ dày từ 6,5 mm xuống 4 mm giúp giảm trọng lượng mà vẫn 

giữ ứng suất tại các thanh dầm trong khoảng 1.607-8.943 MPa, hoàn toàn an toàn dưới tải 

trọng dọc (N1 = -0.8G). Phương án này không chỉ tối ưu hóa vật liệu mà còn cải thiện hiệu 

suất tổng thể. Tuy nhiên, cần đánh giá thêm ảnh hưởng đến độ cứng khung xe khi biến 

dạng tăng do giảm độ dày. Hướng cải tiến bao gồm phân tích mỏi để đảm bảo độ bền trong 

điều kiện tải lặp lại và kiểm tra thực tế để xác nhận kết quả mô phỏng. 

2. Đề xuất hướng phát triển và ứng dụng thực tế 

2.1.Hướng Phát Triển Tiếp Theo 

Dựa trên kết quả nghiên cứu cải tiến khung xe Ford Ranger thông qua mô phỏng 

HyperMesh, các hướng phát triển tiếp theo được đề xuất để nâng cao hiệu quả thiết kế và 

đảm bảo tính thực tiễn: 

− Phân Tích Mỏi (Fatigue Analysis):  

Ba trường hợp tải trọng (sập hố, quay vòng, phanh gấp) đều liên quan đến tải lặp lại 

trong thực tế. Cần thực hiện phân tích mỏi trong HyperMesh với số chu kỳ lớn (ví dụ: 

10^5 chu kỳ) để đánh giá độ bền dài hạn của khung xe, đặc biệt tại các khu vực giá đỡ 

giảm chấn (ứng suất tối đa 226 MPa) và 4 thanh dầm ngang (sau khi giảm độ dày xuống 

4 mm). Điều này đảm bảo khung xe không bị nứt hoặc hỏng sau thời gian sử dụng kéo 

dài. 
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− Tối Ưu Hóa Biến Dạng và Độ Cứng:  

Biến dạng tối đa ghi nhận trong sập hố (8.06 mm) và quay vòng (6.67 mm) cần được 

so sánh với ngưỡng cho phép (thường 0.1-0.5% chiều dài khung). Nếu vượt ngưỡng, cần 

gia cố thêm tại các điểm yếu (ví dụ: thêm gusset plates hoặc tăng bán kính cong tại giá đỡ 

giảm chấn) để tăng độ cứng tổng thể, đảm bảo an toàn khi vận hành. 

− Kiểm Tra Các Điều Kiện Tải Khác:  

Ngoài ba trường hợp đã mô phỏng, cần xem xét các tải trọng thực tế khác như va 

chạm ngang (side impact), tải xoắn (torsional load), hoặc tải nhiệt (thermal load) để đánh 

giá khả năng chịu đựng toàn diện của khung xe. Điều này giúp mở rộng phạm vi ứng 

dụng của thiết kế trong các tình huống phức tạp. 

− Tích Hợp Công Nghệ Mới:  

Áp dụng vật liệu tiên tiến (như thép cường độ cao hoặc hợp kim nhôm) để thay thế 

thép thông thường, vừa giảm trọng lượng vừa tăng độ bền. Sử dụng công cụ tối ưu hóa 

topo (topology optimization) trong HyperMesh để tìm ra thiết kế lý tưởng, giảm vật liệu 

tại các khu vực không cần thiết mà vẫn đảm bảo hiệu suất. 

− Phát Triển Mô Hình Toàn Diện:  

Mô phỏng hiện tại tập trung vào khung xe, nhưng cần mở rộng để bao gồm các hệ 

thống liên quan như hệ thống treo, bánh xe, và động cơ. Điều này giúp đánh giá tác động 

tổng thể của các cải tiến lên hiệu suất xe, đặc biệt là khả năng giảm dao động và ổn định 

khi vận hành. 

2.2. Ứng Dụng Thực Tế 

Các kết quả và phương pháp cải tiến từ nghiên cứu có thể được ứng dụng trong 

nhiều khía cạnh thực tế, đóng góp vào việc phát triển khung xe Ford Ranger và các dòng 

xe tương tự: 

− Sản Xuất Khung Xe Tối Ưu:  

Phương án Lightweighting Design (rút vật liệu tại 4 thanh dầm ngang, giảm độ dày từ 6,5 

mm xuống 4 mm) đã giảm trọng lượng khung xe khoảng 1-1.5 kg mà vẫn đảm bảo ứng 

suất an toàn (dưới 50-100 MPa). Ứng dụng này giúp tiết kiệm chi phí vật liệu (ước tính 

10-20 USD mỗi khung) và cải thiện hiệu suất nhiên liệu, phù hợp với xu hướng xe thân 

thiện môi trường. 

− Nâng Cao An Toàn và Độ Bền:  
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Việc di chuyển lỗ lắp giảm chấn và tăng bề dày cục bộ đã giảm ứng suất tại giá đỡ từ 

471.85 MPa xuống 226 MPa, đảm bảo khung xe chịu được tải trọng khắc nghiệt (sập hố, 

quay vòng, phanh gấp). Thiết kế này có thể áp dụng trực tiếp vào sản xuất để tăng độ bền 

và an toàn, đặc biệt trong các điều kiện địa hình khó khăn mà Ford Ranger thường vận 

hành. 

− Thử Nghiệm Thực Tế:  

Sử dụng kết quả mô phỏng để chế tạo khung xe thử nghiệm, sau đó thực hiện các bài 

kiểm tra thực tế (crash test, durability test) với các điều kiện tải tương tự (sập hố: -2.0g, 

quay vòng: -1.0g, phanh gấp: -0.8g). Điều này giúp xác nhận độ chính xác của mô phỏng 

và điều chỉnh thiết kế trước khi đưa vào sản xuất hàng loạt. 

− Ứng Dụng Trong Dòng Xe Khác:  

Phương pháp cải tiến (Lightweighting Design, di chuyển lỗ, tăng độ dày cục bộ) có thể 

được áp dụng cho các dòng xe tải nhẹ hoặc SUV khác của Ford hoặc các hãng khác, đặc 

biệt là những mẫu xe cần cân bằng giữa trọng lượng và độ bền. Ví dụ, Ford Everest hoặc 

Toyota Hilux có thể tận dụng phương pháp này để tối ưu hóa khung xe. 

− Hỗ Trợ Phát Triển Xe Điện:  

Với xu hướng xe điện (EV) ngày càng phổ biến, thiết kế khung xe nhẹ nhưng bền là yếu 

tố quan trọng để tăng phạm vi hoạt động (range). Kết quả nghiên cứu có thể được áp 

dụng để phát triển khung xe cho các mẫu EV của Ford, đảm bảo trọng lượng nhẹ (sau khi 

giảm 1-1.5 kg) và độ bền cao (ứng suất dưới 250 MPa), hỗ trợ tích hợp pin nặng mà 

không làm tăng tổng trọng lượng xe. 
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